Chapter 6

Schematic Editing

Learning Objectives

After completing this chapter, you will be able to:

* Use basic schematic editing commands

* Update components from catalog database

* Update a schematic component from a one-line component

* Toggle between the normally open and normally closed contacts and vice-versa

* Copy the catalog assignment and location values from one component to multiple
components

* Use auditing tools to find out errors in the project and rectify them

* Retag the drawings

* Use the tools for editing attributes
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INTRODUCTION

In this chapter, you will learn about different tools that are used to create or modify electrical
schematic. You can edit, move, copy, and align components in your drawing. These tools are
very important as they provide extra functionalities to electrical schematic drawings. Also, later
in this chapter, you will learn about surfing of components, auditing tools, editing tools of
attributes, and retagging of drawings.

CHANGING THE COMPONENT LOCATION WITH SCOOT
TOOL

Ribbon: Schematic > Edit Components > Modify Components drop-down > Scoot
Toolbar: ACE:Main Electrical > Scoot or ACE:Scoot > Scoot

Menu: Components > Scoot

Command: AESCOOT

+ The Scoot tool is used to move objects such as components,
S terminals, PLC I/O modules, signal arrows, wire segments, |-
wires with wire crossing-loops, ladder rungs, ladder buses, o ot

and so on in the drawing. The Scoot tool is similar to the AutoCAD +

Move tool. However, the Scoot tool has intelligence about electrical EEFE Align

objects, which enables you to reposition electrical objects. Also, this
tool is used to reconnect wires after repositioning the components. ‘C;: Move Component
To scoot components, choose the Scoot tool from the Modify ¥
Components drop-down in the Edit Components panel of the %ﬁ Reverse/Flip Companent
Schematic tab, as shown in Figure 6-1; you will be prompted to
select component, wire, or wire number for scoot. Select the % Stretch PLC Module
component to scoot along with its connected wire; a —
temporary graphic indicating that you have selected the 57 Split PLC Module
component will be displayed. Next, move the cursor to a place
where you want to locate the component; the selected object will
move in the orthogonal direction to the specified location.

Figure 6-1 The Modify
Components drop-down

Also, the wires will be reconnected after you scoot the components,
the components will be updated, and the existing wire numbers will be recentered. Next, press
ESC or click on the screen to exit the command.

Figures 6-2(a) and 6-2(b) show the components and wires before and after scooting.

If you move components to a location that requires component updates, the Component(s)
Moved dialog box will be displayed, as shown in Figure 6-3. The options in this dialog box are
discussed next.

OK to Retag

Choose the OK to Retag button to retag the components automatically. Now, if the moved
component is linked to other components in the current drawing, the AutoCAD message box will
be displayed, as shown in Figure 6-4. Choose the OK button to update the related component in
the drawing.
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Figure 6-2(a) Components and wires before Figure 6-2(b) Components and wires
scooting after scooting
Component(s) Moved @
Component(s) have moved to new line references.
Would you lilke to run Auto-Retag on the component(s)?
OKto Retag Mo Retag, Leave "asis”
[ OKto Retag ] [ Mo Retag ] [ Update child crossreferences only ]
Figure 6-3 The Component(s) Moved dialog box
AutoCAD [
Scoot Linked Components?
Figure 6-4 The AutoCAD message box
Also, if the component that you have moved consists Update other drawings? ==

of child components or related panel components
in the other drawings of the active project, the
Update other drawings? message box will be
displayed, as shown in Figure 6-5. Choose the OK
button from the Update other drawings? message
box to batch process or update the other drawings
of a project.

Other drawings in the project set may include
child components or related panel components.
These will no longer match the retagged parents.

Drawings to process: 1
Components to update: 1

Breakdown by categony:
Panel symbol update: 1

Batch process/update now?
[ ok ][ Tesk | [ Skip |

Choose the Task button to save all modifications
in the task list to be run later. The task list is

maintained inside the project task list database
file (project_update.mdb). You can access this list
by choosing the Project Task List button from
the Project Manager. Choose the Skip button to
skip the batch process.

message box

Figure 6-5 The Update other drawings?
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Note

@ If the moved component does not have related components in the current drawing, the Update
other drawings? message box will be displayed directly after choosing the OK to Retag button
from the Component(s) Moved dialog box.

If the moved component has related components in the current drawing as well as in the other
drawings of the project, the Update other drawings message box will be displayed after choosing
the Yes-Update button in the Update Related Component? message box.

No Retag

If you do not want to retag a component, choose the No Retag button.

Update child cross-references only

Choose the Update child cross-references only button to update only the child cross-references.

Note

@ If you select a wire segment that contains components to scoot, the entire wire along with its
components and bus will be scooted. If they move to a new line reference, you can auto-retag
components by choosing the OK to Retag button from the Component(s) Moved dialog box.

CHANGING COMPONENT LOCATIONS USING THE
MOVE COMPONENT TOOL

Menu: Schematic > Edit Components > Modify Components drop-down
> Move Component

Toolbar: ACE:Main Electrical > Scoot > Move Component
or ACE:Scoot > Move Component

Menu: Components > Move Component

Command: AEMOVE

<+ | The Move Component tool is used to move the selected component from its current
ﬂ location or wire location to the specified location. To do so, choose the Move

Component tool from the Modify Components drop-down in the Edit Components
panel of the Schematic tab, refer to Figure 6-1; you will be prompted to select a component to
move. Select the component; you will be prompted to specify insertion point. Specify the insertion
point for the component; the selected component will be moved to the specified location, the
underlying wires will be reconnected, and the component tags will be updated automatically.
Figures 6-6(a) and 6-6(b) show the components before and after they are moved.

If you move objects to a location that needs component updates, the Component(s) Moved
dialog box will be displayed, refer to Figure 6-3. The options in this dialog box have been
discussed earlier.
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Figure 6-6(a) Components before using Figure 6-6(b) Components after using the
the Move Component tool Move Component tool
COPYING A COMPONENT
Ribbon: Schematic > Edit Components > Copy Component
Toolbar: ACE:Main Electrical > Copy Component
Menu: Components > Copy Component

Command: AECOPYCOMP

ﬂ The Copy Component tool is used to copy the selected component and insert the copied
component to the specified location in the drawing. To do so, choose the Copy
Component tool from the Edit Components panel of the Schematic tab; you will be
prompted to select the component to copy. Select the component to be copied; you will be
prompted to specify the insertion point for the copied component. Specify the insertion point;
the Insert / Edit Component dialog box will be displayed, as shown in Figure 6-7. The options
in this dialog box have already been discussed in Chapter 5.

Next, enter the required values in this dialog box and choose the OK button; the values along
with the copied component will be displayed in your drawing. If you do not change the values
displayed in the Insert / Edit Component dialog box, the values of the original component
will be transferred to the copied component. Also, the copied component will be retagged
automatically and wire numbers will get updated accordingly.

Note
1. If the selected component that you want to copy is a child component, the Insert / Edit Child
Component dialog box will be displayed instead of the Insert / Edit Component dialog box.

2. You can also copy the components using the COPY command of AutoCAD, but in this case, the
components will not get retagged and the wires will not get reconnected automatically.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Insert / Edit Component (=3
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Figure 6-7 The Insert / Edit Component dialog box

ALIGNING COMPONENTS

Ribbon: Schematic > Edit Components > Modify Components drop-down > Align
Toolbar: ACE:Main Electrical > Scoot > Align or ACE:Scoot > Align
Menu: Components > Align

Command: AEALIGN

|:|:| The Align tool is used to line up components vertically or horizontally. To do so, choose
ES | the Align tool from the Modify Components drop-down in the Edit Components

panel of the Schematic tab; you will be prompted to select the components to be aligned.
Select the components; a temporary line passing through the center of the component will be
displayed. This component is treated as the reference or master component with which you
need to align the rest of the components that you select. Next, select the components to align
with the master component and then press the ENTER key; all the selected components will be
aligned to the master component.

Figure 6-8 (a) shows the components before alignment, Figure 6-8 (b) shows the master
component along with a dashed line, and Figure 6-8 (c) shows the components after alignment.
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Figure 6-8(c) Components afler alignment

DELETING COMPONENTS

Ribbon: Schematic > Edit Components > Delete Component
Toolbar: ACE:Main Electrical > Delete Component
Menu: Components > Delete Component

Command: AEERASECOMP

ﬂ The Delete Component tool is used to delete a component from the drawing. Also,
¥| after deleting the component, the wires get reconnected and the wire numbers get

updated. To delete a component, choose the Delete Component tool from the Edit
Components panel of the Schematic tab from the menu bar; you will be prompted to select
components. Select the component(s) and press the ENTER key or right-click on the screen;
the component(s) will be deleted.

If you select a parent component that has child contacts, the Search for / Surf to Children?
dialog box will be displayed, as shown in Figure 6-9.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Choose the No button in the Search for / Surf to Children? dialog box to delete the
component. If you choose the OK button, the QSAVE message box will be displayed, as shown
in Figure 6-10.

Search for / Surf to Children? |
CR1
This Parent device was deleted.

Do you want to search for and Surf to QSAVE @
its child/peer device contacts {f any)?
Olay to GSAVE this drawing?

[ N | [ ok | [ Cancel | | AwaysQSAVE |

Figure 6-9 The Search for / Surf Figure 6-10 The QSAVE message box
to Children? dialog box

Next, choose the OK button from the QSAVE message box; the active drawing will be saved.
After choosing the OK button, the component will be deleted and the drawing will be updated.
But if the selected component has its references in the current drawing and you choose the OK
button in the QSAVE message box, the Surf dialog box will be displayed. The options in this
dialog box are used to modify or delete the related components. The options in the Surf dialog
box are discussed later in this chapter.

If you choose the No button from the QSAVE message box, the drawing will not be saved and the
component will be deleted. But if the selected component has its references in the current drawing
and you choose the No button in the QSAVE message box, the Surf dialog box will be displayed.
The options in this dialog box are discussed in detail in the later section.

If you choose the Always QSAVE button, AutoCAD Electrical will save the active drawing for
that session without displaying the QSAVE message box each time.

If you choose the Cancel button, the component will be deleted and the references of the
component will not be displayed.

UPDATING COMPONENTS FROM CATALOG DATABASE

Ribbon: Project > Other Tools > Component Update From Catalog
Menu: Projects > Extras > Component Update From Catalog
Command: AEUPDFROMCAT

%a You have already learned in detail about assigning catalog values to a component from the
catalog database in Chapter 5. If these values are changed later in the catalog database,
you can update them using the Component Update From Catalog tool. You can create two

reports using this feature: Error Exception Report and Components Updated From Catalog

Report. To generate these reports, choose the Component Update From Catalog tool from the

Other Tools panel of the Project tab; the Component Update From Catalog dialog box will be

displayed, as shown in Figure 6-11. The options in this dialog box that are used to generate

these two reports are discussed next.

Update Components on Area
Select the Project radio button in this area and choose OK; the Select Drawing to Process dialog
box will be displayed. Select the drawings for which you want updates for the component catalog
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values and choose the Process button; the selected drawings will be transferred from the top list
to the bottom list of this dialog box. Next, choose OK from this dialog box; the Error Exception
Report dialog box will be displayed, refer to Figure 6-12. This dialog box contains three columns:
Component, Location, and Comment in which the list of exceptions, if any, are displayed for
the selected drawings. It also includes all pinlist updates for surfing the child contacts. You can
then manually update the child contacts per drawing. When you choose the Components button
at the bottom left of this dialog box, the Components Updated From Catalog Report dialog
box is displayed. This dialog box provides the details of the component name, its location, data
updated, previous data, and current data per drawing, as shown in Figure 6-13.

Compenent Update From Catalog
Update Components on:

@ Project
Active drawing (all)
Active drawing (pick)

View Previous Report:

Exception View last Emor/Exception report file

Components View last Components Updated report file

Settings

Teat Value
Teminal Properties
Pin List Data

Overnrite
Exdsting
@

)

-}

Blank Existing Child Pin List Assignments

WebLink

Lok ]

[ cancal | [ Hep |

(B>

Update
Blank Only

Figure 6-11 The Component Update From Catalog dialog box

Choose the Surfbutton; the Surf dialog box will be displayed. The options in this dialog box are
discussed in detail in the later section. You can also print the data by choosing the Print button.

Error Exception Report

Report: 9/16/2815 18:54:37 AH
DRAWING DEMOB2 .DWG

Component Location
EYE] 289
Ha1y4 288
Ha1y4 288
Ha1y4 287
Hy22 213
Hy22 211
Hu22 212
Hu22 212
DRAWING DEMOB4.DUWG
Component Location
Hu22 423
H425 426

4

View last Emor/Exception report file

=N

Comment

Pin list
Pin list

Components View last Components Updated report file

data has changed.
data has changed.
data has changed.
data has changed.
data has changed.
data has changed.
data has changed.
data has changed.

data has changed.
data has changed.

After updating, use Component

Child
Child
Child
Child
Child
Child
Child
Child

Child
Child

Cross-Reference to update
graphical and table displays.

I Prirtt I I Close I

C:/Users/CADCIM/ App Data/Roaming/Autodesk./AutoCAD Electrical 2016/R20.1/enu/Support /user/updfromcat bad

contacts
contacts
contacts
contacts
contacts
contacts
contacts
contacts

contacts
contacts

may
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may
may
may
may
may

may
may

==

require
require
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require
require
require
require
require

require
require

b

Figure 6-12 The Error Exception Report dialog box
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Components Updated From Catalog Report @
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Figure 6-13 The Components Updated From Catalog Report dialog box

When you select the Active drawing(all) radio button and then choose OK in the Component
Update From Catalog dialog box, an error exception report only for the active drawing is
displayed in the Error Exception Report dialog box. Similarly, if you choose the Components
button in this dialog box, the Components Updated From Catalog Report dialog box will be
displayed. It provides the details of the component name, its location, data updated, previous
data, and current data for the active drawing only.

Select the Active drawing(pick) radio button if you want to get the error exception report and
component updation report for a specific component.

View Previous Report Area

In this area, choose the Components button to view the report of the component updates from
the previous use of this feature. Similarly, choose the Exception button to view the previous
exception report.

Settings Area

The options in this area are discussed next.

TextValue

By default, the TextValue check box is selected. As a result, the attribute values assigned by the
current TextValue are updated in the catalog database for the catalog number. These values
overwrite the existing values as the Overwrite Existing radio button next to this check box is
selected by default. If you want to retain the existing values, you can select the Update Blank
Only radio button.
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Terminal Properties

By default, the Terminal Properties check box is selected. As a result, the terminal properties
are updated on the terminal to match the value in the catalog database for the assigned catalog
number. Note that the related terminals on other drawings are also updated to keep consistency
in all the terminals. If you want to retain the existing values, you can select the Update Blank
Only radio button.

Pin List Data

By default, the Pin List Data check box is selected. As a result, pinlist value on the schematic
parent is updated so as to match the value in the catalog database for the assigned catalog number.
If you want to retain the existing values, you can select the Update Blank Only radio button.
Note that the child contact pins are not updated here. Make sure that the Blank Existing Child
Pin Assignments radio button below this check box is selected so that the manual pin assignment
becomes easier. Also, note that when you choose the Surf button in the Error Exception Report
dialog box, the Surf dialog box is displayed. This dialog box provides the list of child contacts
of the parents for which the pinlist data is updated.

WebLink
If you select this check box, weblink value of the component is updated to match the value in
the catalog database for the assigned catalog number.

UPDATING A SCHEMATIC COMPONENT FROM A .
ONE-LINE COMPONENT

You can update a schematic component from a one-line component. In other words, you can
copy information such as descriptions, catalog values, installation/location codes, and so on from
a one-line component to a schematic component. To do so, choose the Edit tool from the Edit
Components drop-down in the Edit Components panel of the Schematic tab and select the
schematic component to be updated from the active drawing; the Insert/Edit Component dialog
box will be displayed. In this dialog box, choose the Schematic button from the Component Tag
area; the XX Tags in Use dialog box will be displayed. Note that XX stands for the schematic
component to be updated. In this dialog box, select the Show one-line components (1-*) check
box from the Show area; one-line components will be displayed along with the other components,
refer to Figure 6-14.

Next, select the desired one-line component from the list. Also, select the check boxes in the
Copy area based on the requirement and choose the Copy Tag button; the Copy Tag dialog
box will be displayed, as shown in Figure 6-15. Choose the Tagl button from the Option 1 area
in this dialog box; the Copy Tag dialog box will disappear and the Insert/Edit Component
dialog box will be displayed with the updated values of the schematic component. Choose the
OK button in this dialog box to update the schematic component from a one-line component.

In AutoCAD Electrical 2016, the Show paired one-line components check box is available in
the Show area of the XX Tags in Use dialog box. You need to select this check box along with
the Show one-line components (1-*) check box and the Show parent / stand-alone references
check box to show pair of matching one-line components with schematic or panel component.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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M Tagsin Use @
Sot: @ Tag () Drawing Sequence () Description
Tag Installztion Location Shest Description 1,2,3
422 MCABS 4 HYDRAULIC MOTOR
1425 MCABS 4 INDEXING MOTOR
M433 MCABS 4 UNWIND WEB MOTOR
M435 MCABS 4 REWIND WEE MOTOR

Show Copy
Show parent / stand-alone references [7] Descriptions
[ Shaw child references [T Catalog values
Show all companents for al famiies
a : [T Installation/Location
[7] Show all panel compenerts ()
[7] Show enedine components (1) [ Retings
[7] Show paired one-ine components [C] Al of the above
Copy Tag Calculate Next Help

Figure 6-14 The M Tags in Use dialog box

Copy Tag @

Option 1
Main component Tag attibute value

TAGT Cwverwrite tag MOT212 with MOT232 7

Option 2
This component includes an "atemate tag” reference.
It is camied on an attibute called WD TAGALT.
This can be used to establish a peerto-peer relationship
with @ component on another drawing type.
(e instrument dwg <—> electrical dwg).

WDTAGALT Overwrite tag with MOT232 7

Figure 6-15 The Copy Tag dialog box

SURFING A REFERENCE

Ribbon: Project > Other Tools > Surfer drop-down >Surfer
Toolbar: ACE:Main Electrical 2 > Surfer or ACE:Surfer
Menu: Projects > Surfer

Command: AESURF

The Surfer tool is used to search the related references of a component, wire number,
% terminal, cables, and signal. Using this tool, you can move from one reference to
another across the drawings of a project. This tool is also used to search component tag,
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wire number, item number or catalog number. To search the related references of a component,
choose the Surfer tool from the Other Tools panel of the Project tab; you will be prompted to
select the tag for surfer trace. Select the component or the component tag; the Surf dialog box
will be displayed, as shown in Figure 6-16. This dialog box displays the name of component,
manufacturer code, and catalog number of the selected component at the top. Different options
in this dialog box are discussed next.

Type
Different codes for different type of symbols are displayed in the Type column. These codes are:
- Component symbol
p- Parent symbol or one-line symbol. Note that in case of one-line symbol, ‘1-" will be
displayed in the Category column in the Surf dialog box
t- Terminal symbol
w - Wire number
#- Panel symbol
#np - Panel nameplate
Dst -  Destination arrow
Src - Source arrow
Surf (25
DS304 references
Manufacturer: AB
Catalog:  154E-AZ5-1753
Type Sheet Reference  Installation Location
254 3,304 MCAB5
p 25 3,304 MCAB5
1| 1 5
Show more
[ Feshen | [ Edt | [CatslgCheck| [ Pan |
’ Zoom Save ] [ Delete ] [ Picle Mew List ] ’ Zoom In ]
’ Go To ] [ Close J [ Help ] y

Figure 6-16 The Surf dialog box

Sheet,Reference

This column displays the sheet number and line reference number of the component.

Installation

This column displays the installation value of the selected component.

Location

This column displays the location value of the selected component.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Category
The category of the selected component is displayed in the Category column such as ‘1-’ in
case of one-line symbols.

Show more

The Show more check box will be activated only when you are in the IEC tagging mode, or
if any non-installation/location matching references are not present. Select this check box to
display extra non-installation/location matching reference if you are using the IEC tagging
mode. By default, the Show more check box is clear. As a result, only the exact surf matches in
the list will be displayed.

Freshen

The Freshen button is used to refresh the Surf dialog box with the changes made in the active
drawing. To refresh the Surf dialog box, select a reference from the list displayed and choose
the Freshen button; the QSAVE message box will be displayed. Next, choose the OK button in
the QSAVE message box to save the changes made in the drawing; the Surf dialog box will be
displayed again. If you choose the NO button from the QSAVE message box, the active drawing
will not be saved and the Surf dialog box will be displayed again.

Edit

The Edit button is used to edit the selected reference. On choosing this button, the Insert / Edit
Component dialog box will be displayed. Using this dialog box, you can edit references. The
options in the Insert / Edit Component dialog box have been discussed in the earlier chapters.

Catalog Check

The Catalog Check button will be activated only if the reference has catalog and
manufacturer information added to it. This button is used to display the Bill of Material of the
selected reference.

Pan
The Pan button allows you to view the portion of the drawing that is outside the current display
area.

Note
When the Tool Palettes is docked, the Pan button does not work.

Zoom Save

The Zoom Save button is used to save the current zoom factor on the WD_M block of the drawing.
To do so, choose the Zoom Save button; the Command prompt will display “Surf zoom factor
saved on WD_M block”.

Zoom In

Choose the Zoom In button to double the size of the drawing.
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Zoom Out
Choose the Zoom Out button to decrease the size of the drawing by half.

Pick New List

The Pick New List button is used to select a new component to surf.

Go To

Choose the Go To button to go to the reference of the selected component. This button zooms
the selected component. If the component is in a different drawing, the drawing that is opened
will be saved and other drawing where the component is located will be opened and the selected
component will be zoomed. Also note that when you select the reference from the list displayed
and choose the Go To button, the selected reference will be zoomed and in the Surf dialog box,
‘x’ will be displayed in the left of the Type column.

Close
Choose the Close button to close the Surf dialog box.

Note
@ If you select the source or destination symbols in the drawing using the Surfer tool, then the Surf
dialog box will look a little different. However, the options will remain the same.

TOGGLING BETWEEN THE NORMALLY OPEN AND
NORMALLY CLOSED CONTACTS

Ribbon: Schematic > Edit Components > Toggle NO/NC
Toolbar: ACE:Main Electrical > Toggle NO/NC
Menu: Components > Toggle NO/NC

Command: AETOGGLENONC

E The Toggle NO/NC tool is used to toggle contacts from normally open to normally closed
ik and vice-versa. In other words, this tool is used to flip contacts from one state to another

(open/closed). To toggle between contacts, choose the Toggle NO/NC tool from the Edit
Components panel of the Schematic tab; you will be prompted to select the component to
toggle NO/NC. Select the component; you will notice that if the component is normally open
(NO), it will change to normally closed (NC) and vice versa. Also, the attribute information will
be extracted from the selected component and the component data will be copied onto the
replacement symbol. The command will continue till you press ENTER or right-click on the
screen.

Figures 6-17 (a) and 6-17 (b) show the contacts of components before and after toggling.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Figure 6-17(a) Contacts of components Figure 6-17(b) Contacts of components
before toggling after toggling
COPYING THE CATALOG ASSIGNMENT
Ribbon: Schematic > Edit Component > Edit Components drop-down >
Copy Catalog Assignment
Toolbar: ACE:Main Electrical > Edit Component > Copy Catalog Assignment
or ACE:Edit Component > Copy Catalog Assignment
Menu: Components > Component Miscellaneous > Copy Catalog Assignment
Command:  AECOPYCAT
@ The Copy Catalog Assignment tool is used to copy the O
catalog part numbers from one component to another. 4
Also, this tool is used to insert or edit the catalog data Edit
of the selected component or footprint. This tool helps in .
assigning the same catalog information to multiple components. Oy Edit
To copy manufacturer, catalog, assembly, and multiple catalog |
attributes from one component to the other selected components, @ Internal Jumper
choose the Copy Catalog Assignment tool from the Edit ~
Components drop-down in the Edit Components panel of the B Fix/UnFix Tag
Schematic tab, as shown in Figure 6-18; you will be prompted 3
to select the master component. Select the component to be [:Q R
treated as master component; the Copy Catalog Assignment
dialog box will be displayed, as shown in Figure 6-19. This dialog % User Table Datz

box displays the catalog data of the selected component.
Figure 6-18 The Edit
Components drop-down

Note

@ If the catalog assignment is not assigned to the master component, the Copy Catalog
Assignment dialog box will not display any catalog data. Also, if you want to modify the catalog
assignment both for the master and child components, choose the Catalog Lookup button from
the Copy Catalog Assignment dialog box. On doing so, the Catalog Browser dialog box will
be displayed. Next, select the desired catalog information and then choose the OK button from this
dialog box; the catalog data will be assigned to the selected component.
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Copy Catalog Assignment @

Manufacturer

Catalog 194E-A25-1752
Step 1: Select part number information.
posembly [ ] T SelectOK

[ Catalog Lookup ] Step 2: Select devices to copy to.

[ Find: Drawing Only ] Mote: child or related devices
are not automatically updated.

Muttiple Catalog They must be included in the selection.

[ Catalog Check |

[ ok | [ Cancal |

Figure 6-19 The Copy Catalog Assignment dialog box

The options in the Copy Catalog Assignment dialog box are discussed next.

Manufacturer

In the Manufacturer edit box, the manufacturer data of the master component is displayed.
You can edit the manufacturer data or enter new data by choosing the Catalog Lookup button,
which is discussed later in this chapter.

Catalog

The Catalog edit box displays the catalog data of the master component. If it is not displayed,
you can enter it by choosing the Catalog Lookup button and then selecting the desired catalog.

Assembly

The Assembly edit box is used to display the assembly code of the master component.

Catalog Lookup

Choose the Catalog Lookup button from the Copy Catalog Assignment dialog box; the Catalog
Browser dialog box will be displayed, which has been discussed in the previous chapters. Select
the catalog information from the Catalog Browser dialog box for the master component and
choose the OK button; the catalog information will be displayed in the Manufacturer and
Catalog edit boxes.

Find: Drawing Only

The Find: Drawing Only button is used to search the symbols of the same family block name
within the active drawing. To do so, choose the Find: Drawing Only button from the Copy Catalog
Assignment dialog box; the xx catalog values (this drawing) dialog box will be displayed. Note
that xx stands for the family block name. This dialog box displays catalog information of the
symbols of the same family type. Select the catalog values from this dialog box and choose OK;
the values will be displayed in the Manufacturer and Catalog edit boxes of the Copy Catalog
Assignment dialog box.
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Multiple Catalog

The Multiple Catalog button is used to add extra catalog information to the selected component.
Also, this button is used to verify the catalog information. To add extra catalog information,
choose the Multiple Catalog button; the Multiple Bill of Material Information dialog box will
be displayed. In this dialog box, you can add extra catalog information. You can add up to 99
additional part numbers to any schematic or panel component. Specify the required options in
this dialog box and then choose the OK button to return to the Copy Catalog Assignment dialog
box; the extra catalog assignment will be displayed adjacent to the Multiple Catalog button.

Catalog Check

The Catalog Check button is used to check for the catalog information of the selected component.
To do so, choose the Catalog Check button; the Bill Of Material Check dialog box will be
displayed. It displays the Bill Of Material of the master component.

After spec1fy.1ng the options in the Copy Different symbol block names =
Catalog Assignment dialog box, choose | e o

the OK button; you will be prompted to | Master HPB11
pick the target component(s). Select the | Copyte: HLTIG
target component(s) and press ENTER;
the catalog information will be copied
to the target component(s). If the target [0k | Cancel |
component consists of catalog data different
from the master component, the Different Figure 6-20 The Different symbol block names
symbol block names dialog box will be  dialog box

displayed, as shown in Figure 6-20.

QK to copy Bill of Matenial catalog assignment anyway ?

If you choose the OK button, the Caution: Existing Data on Target dialog box will be displayed,
as shown in Figure 6-21. Different options in this dialog box are discussed next.

Caution: Existing Data on Target @
Master Component Target Component
Manufacturer BUSSMANN Manufacturer BUSSMANM
Catalog FRS-R-10 Catalog FRS-R-5
Assembly Assembly
Muttiple Catalog Muttiple Catalog

Figure 6-21 The Caution: Existing Data on Target dialog box

The Catalog Check button is used to display the catalog information of the master and target
component(s).

To overwrite the catalog information of the master component to the target
component(s), choose the Overwrite button; the catalog information of the master
component will be applied to the target component(s). But if the target component has its
child contacts or references, then after choosing the Overwrite button, the Update Related
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Components? message box will be displayed. In this message box, choose the Yes-Update
button; the related components will be updated. Choose the Skip button to skip the update of
the related components.

COPYING INSTALLATION/LOCATION CODE VALUES

Ribbon: Schematic > Edit Components > Copy Installation/Location Code Values
Toolbar: ACE:Main Electrical 2 > Location Symbols drop-down>

Copy Installation/Location Code Values

or ACE:Location Symbols > Copy Installation/Location Code Values
Menu: Components > Component Tagging > Copy Installation/Location Code Values
Command: AECOPYINSTLOC

=+ | The Copy Installation/Location Code Copy Installation/Location to Components ==
42F| Values tool is used to copy the | Copylnstalation and/or Location atirbute valuefs)
installation and location code

assignments from one component to another.
To do so, choose the Copy Installation/ Fickc on “ustlike"
Location Code Values tool from the Edit
Components panel of the Schematic tab; the Sclectins: alatox e shaiodies ey
Copy Installation/Location to Components [Jinstallation Location
dialog box will be displayed, as shown in | |

Figure 6-22. Different options in this dialog
box are discussed next.

Optional pick to retrieve existing values

Pick Master
The Pick Master button is used to select the

master component from where the attributes | 3y soisction shove. Select OK

will be copied. To select the master component, L S Rien I BT

choose the Pick Master button; the Copy
Installation/Location to Components dialog
box will disappear and you will be prompted
to select the master component to get the
installation and location values. Select the
component from the drawing; the Copy
Installation/Location to Components dialog box will be displayed again with the installation
and location values of the selected component.

[ ok | [ camesl | [ Hep |

Figure 6-22 The Copy Installation/Location
to Components dialog box

Select Installation/Location codes to copy Area
The options in this area are used to copy the installation and location codes on the selected
component that you will select. These options are discussed next.

Installation

Select the Installation check box; the edit box below this check box as well as the Drawing and
the Pick “Like” buttons will be activated. Next, enter the installation code that you want to copy
from the master component to the other components in the edit box.
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Drawing
The Drawing button is used to display the list of installation codes present in the active drawing.

Project
The Project button is used to display the list of installation codes present in the active project.

Pick “Like”

The Pick “Like” button is used to select the component from where installation values are copied.

Location

The Location check box is selected by default. As a result, the edit box below this check box as
well as the Drawing, Project, and Pick “Like” buttons are active. Enter the location code that
you want to copy from the master component in the edit box below the Location check box.

Drawing
The Drawing button is used to display the list of location codes present in the active drawing.

Project
The Project button is used to display the list of location codes present in the active project.

Pick “Like”

The Pick “Like” button is used to select the component from where the location values will be
copied. To do so, choose the Pick “Like” button; you will be prompted to select the component
to get the location code. Select the component; the location code will be displayed in the edit
box, which is below the Location check box.

After specifying the required options in the Copy Installation/Location to Components dialog
box, choose the OK button; you will be prompted to select components. Select the component(s)
to copy the installation/location values and press ENTER; the installation/location values will
be copied to the selected component.

Note
AutoCAD Electrical does not show any warning if you overwrite the existing installation and
location codes.

AUDITING DRAWINGS

The auditing tools are used to check errors in the project. These tools help in troubleshooting and
improving the accuracy of a drawing. There are two auditing tools: Electrical Audit and Drawing
Audit. These tools are discussed next.
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Electrical Auditing

Ribbon: Reports > Schematic > Electrical Audit

Toolbar: ACE:Main Electrical 2 > Schematic Reports > Electrical Audit
or ACE:Schematic Reports > Electrical Audit

Menu: Projects > Reports > Electrical Audit

Command: AEAUDIT

F The Electrical Audit tool is used to find out the problems that affect the drawings of a
¥ project. This tool can be used to correct some of the errors in drawings. To find errors,
choose the Electrical Audit tool from the Schematic panel of the Reports tab; the
Electrical Audit dialog box will be displayed, as shown in Figure 6-23. The progress of the
electrical audit will be displayed in the edit box. Once the audit is finished, the edit box will
display the total number of errors that occurred in the active project. In this dialog box, the
Project radio button is selected by default. As a result, the total number of errors found in the
active project will be displayed in the edit box of the Electrical Audit dialog box. If you select
the Active Drawing radio button, then the total number of errors found in the active drawing
will be displayed in the edit box. This dialog box also displays the date and time of the electrical
audit report.

Electrical Audit (=3
Project: NFPAdemo wdp Date/Time:  9/1/2015 5:46:59 PM
@ Project
() Active Drawing 50 Emoris) Found

[ Details ¥ ] [ Close ] [ Help

Figure 6-23 The Electrical Audit dialog box

The Details button is used to view errors as well as to expand or collapse the Electrical Audit
dialog box. To view errors, choose the Details button; the Electrical Audit dialog box will
expand and display the detailed information about the errors found in the project, as shown
in Figure 6-24. If you choose this button again, the Electrical Audit dialog box will collapse,
refer to Figure 6-23.

, Note
@ If the active drawing is not a part of the active project, then the Active Drawing radio button
will not be activated in the Electrical Audit dialog box.

If errors are not found in a project or active drawing, then the Details button in the Electrical
Audit dialog box will not be activated.

The expanded Electrical Audit dialog box has ten different tabs. If the tab has a red circle
and a white ‘X’, it means an error is present in that category. To view the errors present in a
tab, choose the tab; the information about the errors will be displayed in the lower part of the
Electrical Audit dialog box.
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Electrical Audit
Project:  NFPAdemo.wdp Date/Time:  9/2/2015 4:.08:15FPM
@ Project

Active Drawing 50 Emoris) Found
Close ] ’ Help
Teminal Duplication | PFin Exception | & Contacts

& Component - Mo Catalog Number I & Component Duplication

& Componert - No Connection | Mixed Component Network
€@ Wire - No Connection | Wire Exception | Cable Exception
Wire Number Ermor Message Drawing Location
202 Unconnected wires DEMODZ DWG (1.38 20.00)
2024 Unconnected wirss DEMOD3.DWG (10.25 20.00)
203 Unconnected wires DEMOD2 DWG (1.3819.50)
203A Unconnected wires DEMO03.DWG (10.25 19.50)
2038 Unconnected wires DEMO02 DWG (1.3815.00)
203C Unconnected wires DEMO03.DWG (10.25 15.00)
309 Unconnected wires DEMOO4.DWG (17.25 4.00)
3058 Unconnected wires DEMOO4.DWG (27.38 4.00)
3058 Unconnected wires DEMOO7 DWG (2750 5.88)
324 Unconnected wires DEMOO7 DWG (16.50 5.88)

Go To ] ’ Save As ] ’ Save Al ] ’ Prirt
Recovery Tip: Use "Go To" to browse to the emor location, comect wires with no connection (10 emors)

Figure 6-24 The expanded Electrical Audit dialog box displaying errors on
choosing the Details button

Different tabs in the Electrical Audit dialog box are discussed next.

Wire - No Connection

By default, the Wire - No Connection tab is chosen in the Electrical Audit dialog box. This
tab displays the disconnected wires that are found in the project. The report list below this tab

Wire Exception
The Wire Exception tab displays the missing or the duplicated wire numbers that are found

in an active project.

consists of disconnected wire number, error message, drawing, and the location point where an
error occurs. If wire number record is not found in the drawings of a project, the Wire Number
column will be blank.
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Cable Exception
The Cable Exception tab displays the duplicated cable and the wire ID’s that are found in an
active project.

Component - No Catalog Number
The Component - No Catalog Number tab displays the components that have no catalog data.

Component Duplication
The Component Duplication tab displays the duplicated schematic/panel components.

Component - No Connection
The Component - No Connection tab displays the component connections with disconnected wires.

Note
For a schematic component, the corresponding field in the Category column is blank.

Mixed Component Network

The Mixed Component Network tab displays components in a wire network that consists of
components of different types such as one-line symbols, schematic symbols, and so on. To view
the mixed components in a wire network, choose the Mixed Component Network tab; the report
list will be displayed containing the tag name of the component (from/to), component type (from/
to), error message, and the name of the drawing (from/to) where an error occurs.

Terminal Duplication
The Terminal Duplication tab displays the duplicated schematic terminal numbers.

Pin Exception
The Pin Exception tab displays the pin assignments of a component that has been duplicated.

Contacts
The Contacts tab displays a child component without a parent.

Recovery Tip
The Recovery Tip area at the bottom of the Electrical Audit dialog box displays the recovery tip
to fix an error in the drawing.

Go To

The Go To button takes you to an error location within the project and corrects the error. To go
to an error location, select the error from the report list displayed in the Electrical Audit dialog
box and then choose the Go To button. Alternatively, double-click on the error displayed in the
Electrical Audit dialog box; the current drawing will be saved. Also, the drawing that contains the
selected error will be opened and the selected component will be zoomed and highlighted. As
the component gets highlighted, it is easier to identify the object with error. Now, you can edit
the selected component without closing the Electrical Audit dialog box. To do so, right-click
on the selected component in the drawing area; a shortcut menu will be displayed. Choose the
required component editing option from the shortcut menu; the corresponding editing dialog
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box will be displayed. In this dialog box, specify the required options and then choose the OK
button to exit the dialog box. Once you go through an error location, an ‘x’ will appear in the
extreme left column of the Electrical Audit dialog box.

Save As
The Save As button is used to save an active audit report to a text file.

Save All

The Save All button is used to save a complete audit report to a text file.

Print

The Print button is used to print an audit report. On choosing this button, the Print dialog
box will be displayed, as shown in Figure 6-25. Select the name of the printer from the Name
drop-down list and then choose the OK button; the audit report will be printed.

Q;q Print @
General
Select Printer
%Add Printer E;QMicrosaftXPS Documen
=5 Adobe PDF =0 Send To OneMNote 2013
=l Fax
4| 1] +
Location:
Comment
Page Range
@ Al Number of copies: 1
Selection Cument Page
Pages: Collate
1] 221 313

Figure 6-25 The Print dialog box

Auditing a Drawing

Ribbon: Reports > Schematic > DWG Audit

Toolbar: ACE:Main Electrical 2 > Schematic Reports > Drawing Audit
or ACE:Schematic Reports > Drawing Audit

Menu: Projects > Reports > Drawing Audit

Command: AEAUDITDWG

|_3| The DWG Audit tool is used to find out the problems in wiring that affect the wire
# connectivity of a design. Using this tool, you can audit a single drawing or multiple

drawings in a project. The auditing of a drawing is performed to check for wire gaps,
wire number, color, zero length wires, gauge labels, and wire number floaters for errors, and so
on. To find out errors in wires and to rectify them, choose the DWG Audit tool from the Schematic
panel of the Reports tab; the Drawing Audit dialog box will be displayed, as shown in Figure
6-26. Different options in the Drawing Audit dialog box are discussed next.
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Drawing Audit IEI

Audit drawing or project
@) Active drawing
() Project
Re-display last report Date/Time: 9/1/2015 5:37.37 PM

Project: NFP Ademo
Surf

[ ok || cancel | [ Hep |

Figure 6-26 The Drawing Audit dialog box

The Audit drawing or project area consists of two radio buttons: Active drawing and Project.
These radio buttons are discussed next.

Auditing an Active Drawing
The Active drawing radio button is selected by default and is used to audit an active drawing
only. Choose the OK button from the Drawing Audit dialog box; the modified Drawing Audit
dialog box will be displayed, as shown in Figure 6-27. The options in the modified Drawing
Audit dialog box are discussed next.

Drawving Sudit @
“wiire gap pointers

Bogug wire number and color/gauge label pointers

Zero length wires

“wire number floaters

Show wires (mark in red)

[ ak ][ Cancel ][ Help ]

Figure 6-27 The modified Drawing Audit dialog box

Wire gap pointers
This check box is used to find out the problems related to the missing wires that were
connected through gap pointers.

Bogus wire number and color/gauge label pointers
This check box is used to check for and clean up the wires that have non-existent wire
numbers. Also, this check box is used to check for bad color/gauge label pointers.

Zero length wires
This check box is used to check and erase the zero length line entities present on a wire layer.

Wire number floaters
This check box is used to check and erase the wire numbers that are not linked to a wire
network.

Show wires (mark in red)

This check box is used to display a red outline around each wire entity and magenta outline
around the wires defined on the no wire numbering layers. This check box will be activated
only if you select the Active drawing radio button from the Drawing Audit dialog box.
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After specifying the options in the modified Drawing Audit dialog box, choose the OK button;
the Drawing Audit message box will be displayed, as shown in Figure 6-28. Choose the OK
button in this message box; the Report: Audit for this drawing dialog box will be displayed, as
shown in Figure 6-29. You can save and print a report by choosing the Save As button and the
Print button, respectively from this dialog box.

Drawing Audit @

55 line entities:
~ 55 -wires (Lines on normal wire layers) shown color red,
0 - wires (Lines on "no wire numbering” wire layers) shown color magenta

[T Do not show me this again

Figure 6-28 The Drawing Audit message box

Previous

The Previous button of the Drawing Audit dialog box is activated if you have already generated
the audio report, and is used to display the previous audit report. To do so, choose the Previous
button; the Report: Audit dialog box will be displayed. This dialog box re-displays the last run
audit report.

Report: Audit for this drawing @

Drawing C:AUSERSACADCIMADOCUMENT SNACADE 200 EAAEDATANPROANFPADEMOADEMO D4 DW G
Audit: 3/16/2015 11:38:51 AW

Surf [ Save As ] [ Frint ] [ Close ]

Figure 6-29 The Report: Audit for this drawing dialog box

Auditing an Active Project

The Project radio button is used to audit an active project. To do so, select the Project radio
button from the Active drawing or project area of the Drawing Audit dialog box, refer to Figure
6-26, and then choose the OK button from this dialog box; the modified Drawing Audit dialog
box will be displayed, as shown in Figure 6-30. The options in the modified Drawing Audit
dialog box have already been discussed.

Next, choose the OK button from the modified Drawing Audit dialog box; the Select Drawings to
Process dialog box will be displayed, as shown in Figure 6-31. Select the drawings that you want
to process and choose the Process button from this dialog box; the selected drawings will be
moved from the top list to the bottom list. Next, choose the OK button in this dialog box; the
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QSAVE message box will be displayed, as shown in Figure 6-32. Next, choose the OK button in
the QSAVE message box; the changes made in the current drawing will be saved and the auditing
report of drawings will be displayed in the Report: Audit dialog box, as shown in Figure 6-33.

Drawing Audit

Wire gap pointers

Bogus wire number and color/gauge label pointers
Zero length wires

Wire number floaters

[ ok | [ Cancel | [ Hep |

Figure 6-30 The modified Drawing Audit dialog box

Select Drawings to Process
@ Drawing () Description

Ref Subfolder Section  Sub-Section Project Drawing List ol
SCHEMATIC C:hUsers\CADCIM Documents'Acad...\AeData'proj \NFP Adem
SCHEMATIC C:h\Users\CADCIM\Documents'Acad...\ e Data proj \NFF Adem| =
SCHEMATIC C:hUsers\CADCIM Documents'Acad...\AeData'proj \NFP Adem
SCHEMATIC C:\Users"CADCIM \Documents'Acad...\AeData proj \NFF Adem —
SCHEMATIC C:hUsers\CADCIM Documents'Acad...\AeData'proj \NFP Adem
SCHEMATIC C\Users"CADCIM \Documents'fcad...\ e Data"proj \NFP Adem
CrUCRMATIT 8l T A DU IR Dimmi st n s immid % Am Dl = iy RICD A mm kv

4 T

‘ Process f Reset f n-select by Section./sub-section ][ by Subfolder

Rief Subfolder Section  Sub-Section Project Drawing List

4 1 +
Select from the top list, Ve
insert into the bottom list. K fichy e

Figure 6-31 The Select Drawings to Process dialog box

QSAVE
Ckay to QSAVE this drawing?

[ No | [ oK | [ Cancel | [ AwaysQSAVE |

Figure 6-32 The QSAVE message box

Note
The QSAVE message box will be displayed only if you have made any changes in the current
drawing and have not saved them.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

6-28 AutoCAD Electrical 2016 for Electrical Control Designers

Report: Audit

A16/2015 11:41:30 AM

Drawing: C:AUSERSACADCIMADOCUMENTSWACADE 201 E5AEDATANPROJMNFRPADEMONDEMO 0T D'WGE
Audit: 316/2015 11:47:40 M

Drawing: C:AUSERSACADCIMADOCUMENTSWACADE 201 E5AEDATANPROJNNFPADEMONDEMO 02 D' G
Audit: 31672015 11:41:47 AM

Drawing: C:AUSERSACADCIMADOCUMENTSWACADE 201 E5AEDATANPROJMNFPADEMONDEMO 03D GE
Audit: 316/2015 11:41:42 AM

Drawing: C:AUSERSACADCIMADOCUMENTSWACADE 201 E5AEDATANPROJMNFRPADEMONDEMOO4. D' G
Audit: 31672015 11:41:43 M

Drawing: C:AUSERSACADCIMADOCUMENTSWACADE 201 E5AEDATANPROJNNFPADEMONDEMOOG.D'wW G
Audit: 31672015 11:47:44 AM

Drawing: C:AUSERSACADCIMADOCUMENTSWACADE 201 E5AEDATANPROJNNFPADEMONDEMOOE. D' G
Audit: 31672015 11:41:46 AM

- _____________N

m

Surf [ Save As ] [ Frint ] [ Cloze ]

Figure 6-33 The Report: Audit dialog box

RETAGGING DRAWINGS

Ribbon: Project > Project Tools > Update/Retag

Toolbar: ACE:Main Electrical 2 > Project Manager > Project-Wide Update/Retag
ACE:Project > Project-Wide Update/Retag

Menu: Projects > Project-Wide Update/Retag

Command: AEPROJUPDATE

=)

The Project-Wide Update/Retag tool is used to update the selected drawings in a project.
Also, this tool is used to retag components, update the cross-reference of component,

retag wire numbers and signal references, and so on. To update or retag the drawings
of a project, choose the Update/Retag tool from the Project Tools panel of the Project tab or
choose Projects > Project-Wide Update/Retag from the menu bar; the Project-Wide Update or
Retag dialog box will be displayed, as shown in Figure 6-34. Different options in this dialog box

are discussed next.

Project-Wide Update or Retag

Select options to run on selected drawings from active project.

[~] Component Retag

[] Companent Cross-Reference Update

[] Wire Number and Signal Tag/Retag Setup
[ Ladder References
Resequence Setup

Bump - Up/Down by

]

[] Sheet (%5 value)

Resequence - Start with

Bump - Up/Down by

] Drawing (%D value)
[] Other Corfiguration Settings

[ Title Block Update

[ ok | [ Cancal |

[_Heb |

=5

Figure 6-34 The Project-Wide Update or Retag dialog box
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Component Retag
The Component Retag check box is used to retag all non-fixed components of the selected
drawings.

Component Cross-Reference Update
The Component Cross-Reference Update check box is used to update the cross-reference of
components of the selected drawings.

Wire Number and Signal Tag/Retag

The Wire Number and Signal Tag/Retag check box is used to update signal symbols and the
wire numbers that are not fixed. Select the Wire Number and Signal Tag/Retag check box; the
Setup button will be activated. Using this button, you can insert or update wire numbers that
are linked to wire networks. To do so, choose the Setup button; the Wire Tagging (Project-wide)
dialog box will be displayed, as shown in Figure 6-35. The options in this dialog box have been
discussed in Chapter 3. Specify the required options in this dialog box and then choose the OK
button to return to the Project-Wide Update or Retag dialog box.

Wire Tagging (Project-wide) @

Wire tag mode
(7)) Sequential (1st tag defined for each drawing)

7) Sequential {consecutive drawing to drawing)

@ Reference-based tags

Todo [] Format ovemide
(7)) Tag new./unnumbered onty
@ Tag/retag al

[ Use wire layer format overides

Crosstefersnce Signals

Freshen database for Signals) [ Insert as Fixed

[ ok | [ camcal | | Hep |

Figure 6-35 The Wire Tagging (Project-wide) dialog box

Ladder References

The Ladder References check box is used to renumber the ladders sequentially. To
renumber each ladder of drawings sequentially, select this check box; the options below the
Ladder References check box will be activated. These options are discussed next.

Resequence

The Resequence radio button is selected automatically when you select the Ladder References
check box and is used to define the starting reference number for a ladder. Also, it is used to
define the sequence of ladders in different drawings. The Setup button located on the right of
the Resequence radio button is used to renumber ladder reference. To do so, choose the Setup
button; the Renumber Ladders dialog box will be displayed, as shown in Figure 6-36. Using this
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dialog box, you can renumber the reference numbers of a ladder of the selected drawings in an
active project. The options in this dialog box have already been discussed in detail in Chapter 4.

Specify the required options in this dialog box and choose the OK button to return to the
Project-Wide Update or Retag dialog box.

Bump-Up/Down by

The Bump-Up/Down by radio button is
used to increase or decrease the existing
ladder line reference numbers by a

Renumber Ladders IEI
Ladder Reference Numbers

specified amount. To do so, select this B ] 3 e efaance mamer

radio button; the edit box on the right of

this radio button will be activated. Specify i axlhevaxd

a value in this edit box; the reference @) Use next sequential reference

number of the ladder will change () Skip, drawing to drawing court = L]

accordingly. Also, if you add drawings in
the middle of a project, the ladder
references will move up. However, if you Figure 6-36 The Renumber Ladders dialog box
remove drawings from the project, the

ladder references will move down. If you enter a negative value in the edit box, the line reference
number of the ladder will move down.

[ ok | [ cancel | [ Hep |

Sheet (%S value)

If you select the Sheet (%S value) check box, the options below this check box will be activated.
This check box is used to resequence the sheet value automatically in the successive drawings.

Resequence - Start with
The Resequence - Start with radio button is selected by default and it enables you to enter a
number to start resequencing.

Bump - Up/Down by

Select the Bump - Up/Down by radio button; the edit box adjacent to this radio button will be
activated. Next, enter the required value in the edit box; the current sheet value will move up
or down by the specified value.

Drawing (%D value)

The Drawing (%D value) check box is used to update drawing’s %D (drawing name)
parameter project-wide. Select this check box; the edit box adjacent to this check box will be
activated.

Other Configuration Settings

The Other Configuration Settings check box is used to update the drawing settings of the drawing
related to component, cross-reference, wire numbers, and format project-wide. Select this check
box; the Setup button will be activated. Choose the Setup button; the Change Each Drawing’s
Settings -- Project-wide dialog box will be displayed, as shown in Figure 6-37. The options in
this dialog box are used to change the settings of the drawings. These options are discussed next.
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Change Each Drawing's Settings -- Project-wide @
[7] Component Tagaing Settings [ Wire Mumbering Settings
@ Reference-based (@ Reference-based

List of replaceable parameters
[ Cross-Reference Fomat™ %N reference number
%5 sheet value
%D drawing valus
WA project list drawing's Section code

[ Inter-Drawing Cross-Refersnces® %EB  project list drawing’s Subsection code
%P |EC-style project code
~ %l |EC-style installation
* Contacts and signal references only %L IEC-style loation
[ ok | [ cancal |

Figure 6-37 The Change Each Drawing’s Settings -- Project-wide dialog box

Component Tagging Settings

The Component Tagging Settings check box is used to specify the settings for the component tag.
If you select the Component Tagging Settings check box, the Sequential radio button, the
Reference-based radio button, and the Format edit box will be activated. Select the Sequential
radio button for tagging the components sequentially. The Reference-based radio button is
selected by default. As a result, the components are tagged based on reference of the ladder.
Enter the format for component tagging in the Format edit box. By default, %F%N is displayed
in this edit box.

Cross-Reference Format

The Cross-Reference Format check box is used to specify the format for cross-reference of the
component. Select this check box; the Format edit box will be activated. Enter the format for
cross-reference in the Format edit box. By default, %N is displayed in this edit box.

Inter-Drawing Cross-References
The Inter-Drawing Cross-Reference check box is used to specify the format for the inter-drawing
cross-references.

Wire Numbering Settings
The Wire Numbering Settings check box is used to specify the settings for the wire numbers.
Select this check box; the other options will be activated. These options are discussed next.

Select the Sequential radio button for numbering the wires sequentially. You can enter the
increment value in the increment edit box for wire numbering. Select the Reference-based radio
button for numbering the wires based on reference number of the ladder. Enter the format of
wire numbers in the Format edit box. By default, %N is displayed in this edit box.
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Title Block Update

Select the Title Block Update check box in the Project Wide Update or Retag dialog box to
update the title block information of the active drawing or the entire project. By selecting this
check box, the Setup button next to this check box will be enabled. Choose the Setup button;
the Update Title Block dialog box will be displayed. Using this dialog box, you can update
the attributes of the title block. The options in this dialog box will be discussed in Chapter 12.
Specify the required options in the Update Title Block dialog box and choose the OK button;
you will return to the Project-Wide Update or Retag dialog box.

You can use any one of the options in the Project-Wide Update or Retag dialog box or use all
of them simultaneously by selecting the options displayed in this dialog box. After selecting the
options, choose the OK button from the Project-Wide Update or Retag dialog box; the Select
Drawings to Process dialog box will be displayed. Select the required drawings and choose the
Process button; the selected drawings will be displayed in the bottom list. Next, choose the OK
button from this dialog box; the selected drawings will be processed and updated accordingly.

USING TOOLS FOR EDITING ATTRIBUTES

In AutoCAD Electrical, there are a number of tools that can be used to modify attributes. These
tools are used to modify the attributes of selected symbols but they are not used to modify the
block. In this section, you will learn about different tools used for modifying attributes.

Moving Attributes -
=

Ribbon: Schematic > Edit Components > Modify Attributes »:\ Vovershou Attrbute
drop-down > Move/Show Attribute v

Toolbar: ACE:Main Electrical > Modify Attributes drop-down Edit Selected Attribute

> Move/Show Attribute

or ACE:Edit Attributes > Move/Show Attribute
Menu: Components > Attributes > Move/Show Attribute
Command: AEATTSHOW

Hide Attribute (Single Pick)

@&&

Hide Attribute (Window/Multiple)

Unhide Attribute (Window/Multiple)

The Move/Show Attribute tool is used to move attributes Add Attribute
k| ofa component. 1o do so, choose the Move/Show Attribute

tool from the Modify Attributes drop-down in the Edit
Components panel of the Schematic tab, as shown in Figure 6-38;
you will be prompted to select the attribute to move or pick block
graphics for list. Select the attributes that you want to move and
press ENTER; you will be prompted to specify the base point of
the attribute. Specify the base point for the attribute and press
ENTER or click on the screen; you will be prompted again to
select the attributes to move. Press ENTER to exit the command.
Ifyou enter ‘W’ at the Command prompt, you will be able to move
multiple attributes at a time by selecting attributes using the
crossing window.

Rename Attribute

Squeeze Attribute/Text

R N RN

Stretch Attribute/Text

Change Attribute Size

()

///\‘ //O &

Rotate Attribute

Change Attribute Justification

]

Change Attribute Layer

Figure 6-38 The Modify
Attributes drop-down
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Editing Attributes

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Edit Selected Attribute

Toolbar: ACE:Main Electrical > Modify Attributes drop-down > Edit Selected Attribute
or ACE:Edit Attributes > Edit Selected Attribute

Menu: Components > Attributes > Edit Selected Attribute

Command: AEEDITATT

The Edit Selected Attribute tool is used to edit the selected attribute. To do so, choose
% the Edit Selected Attribute tool from the Edit Components panel of the Schematic tab;

you will be prompted to select an attribute. Select an attribute; the Edit Attribute dialog
box will be displayed, refer to Figure 6-39.

Edit Attribute - TAGL =
|
similar text

[ ok | [ cancel | [ Hep |

Figure 6-39 The Edit Attribute - TAGI dialog box

Enter the new name for the attribute in the edit box. Alternatively, choose the Pick button
from the Edit Attribute dialog box for selecting the attribute from the current drawing. You
can increase or decrease the selected attribute value by choosing the > and < buttons. Next,
choose the OK button; the name of the selected attribute will be changed to the specified name.
Press ENTER to exit the command. You can also edit components using the Edit tool. To do so,
choose the Edit tool from the Edit Components panel of the Schematic tab; the Insert / Edit
Component dialog box will be displayed. Specify the required description in the Description area
of this dialog box and choose the OK button; the attribute of the component will be changed.
Another method of editing the attribute of a component is by using the Move/Show Attribute
tool. To edit the attribute text of a component, choose the Move/Show Attribute tool from the
Edit Components panel of the Schematic tab; you will be prompted to select an attribute to
move or pick on block graphics for list. Select the graphics of the block; the SHOW / HIDE
Attributes dialog box will be displayed, as shown in Figure 6-40. Next, select the Edit Attributes
check box located at the top right corner of this dialog box; the dialog box will be modified to
the EDIT Attributes dialog box. Next, select the name of attribute from the list displayed in
the EDIT Attributes dialog box; the Edit Attribute dialog box will be displayed. Specify the
required options and choose the OK button in the Edit Attribute dialog box; the attribute value
will be changed to the specified value.
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Hiding Attributes
Ribbon: Schematic > Edit Components >

Modify Attributes drop-down > Hide Attribute (Single Pick)
Toolbar: ACE:Main Electrical > Modify Attributes drop-down >

Hide Attribute (Single Picks)
or ACE:Edit Attributes > Hide Attribute (Single Picks)
Menu: Components > Attributes > Hide/Unhide Attribute >
Hide Attribute (Single Picks)
Command: AEHIDEATT

The Hide Attribute (Single Pick) tool is used to hide the selected attribute. To do so,
E choose the Hide Attribute (Single Pick) tool from the Modify Attributes drop-down in

the Edit Components panel of the Schematic tab; you will be prompted to select the
attribute to hide or pick on block graphics for list. Select the attribute to hide it. Press ENTER
to exit the command. Note that if you select the graphics of a block, the SHOW / HIDE Attributes
dialog box will be displayed, refer to Figure 6-40. The attributes that have an asterisk (*) displayed
in the Visible column of the SHOW / HIDE Attributes dialog box are visible in the drawing.
To make these attributes invisible in the drawing, select these attributes in the dialog box; the
asterisk will disappear from the Visible column indicating that the attribute is now invisible in
the drawing. Similarly, if you select the attribute in the dialog box which does not have an asterisk
in the Visible column, the asterisk will appear in this column indicating that the attribute is now
visible in the drawing.

SHOW / HIDE Attributes (HPX11) =)
(%) = visible, select to toggle [ Edit Attributes
Visible Name Attribute Value

ASSYCODE -
CAT EBS-F18A108C02-01 B
CONTACT WO
DESCH PALLET INDEX
DESC2 RIGHT
FAMILY P

- INST 3

- Loc MACHINE i
MF3 EATON

- TAG1 PRS506

- TERMOT

- TERMO2

- TERMO3 -
X1TERMOZ h06

- H2LINK
¥2TERMO3 =

Coc) [

Figure 6-40 The SHOW / HIDE Attributes dialog box

You can hide multiple attributes at a time. To do so, enter ‘W’ at the Command prompt; you
will be prompted to select the attributes. Select the attributes by using the crossing window and
then press ENTER; the attributes will hide. Press ENTER to exit the command. You can also
hide multiple attributes using the Hide Attribute (Window/Multiple) tool. To do so, choose
the Hide Attribute (Window/Multiple) tool from the Edit Components panel of the Schematic
tab; you will be prompted to select the attributes. Select the attribute and press ENTER; the
Flip Attribute to Invisible dialog box will be displayed. Select the required attributes to flip to
invisible and choose the OK button; the attributes will hide. Note that you can select multiple
attributes from the Flip Attribute to Invisible dialog box by using the CTRL or SHIFT key.
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Unhiding Attributes

Ribbon: Schematic > Edit Components >Modify Attributes drop-down >
Unhide Attribute (Window/Multiple)
Menu: Components > Attributes > Hide/Unhide Attribute >

Unhide Attribute (Window/Multiple)
Command: AESHOWATTRIB

E' The Unhide Attribute (Window/Multiple) tool is used to unhide the hidden attributes.
Eu To do so, choose the Unhide Attribute (Window/Multiple) tool from the Modify
Attributes drop-down in the Edit Components panel of the Schematic tab; you will be
prompted to select objects. Select graphics of the symbol block and press ENTER; the Flip
Attributes to Visible dialog box will be displayed. Select the attributes that you want to display
and choose the OK button in the Flip Attributes to Visible dialog box; the attributes will be
visible on the screen. Note that multiple attributes can be selected from the Flip Attributes to
Visible dialog box by pressing CTRL or SHIFT.

Ifyou enter ‘W’ at the Command prompt, you will be prompted to specify the first corner. Specify
the first corner; you will be prompted to specify the opposite corner. Specify the opposite corner
and then press ENTER; the Flip Attributes to Visible dialog box will be displayed. Select one
or more attributes and choose the OK button; the attributes will be flipped to visible.

Adding Attributes

Ribbon: Schematic > Edit Components > Modify Attributes drop-down
> Add Attribute

Toolbar: ACE:Main Electrical > Modify Attributes drop-down > Add Attribute
or ACE:Edit Attributes > Add Attribute

Menu: Components > Attributes > Add Attribute

Command: AEATTRIBUTE

#| The Add Attribute tool is used to add a new attribute to the existing AutoCAD

m Electrical block. To do so, choose the Add Attribute tool from the Modify Attributes

drop-down in the Edit Components panel of the Schematic tab; you will be prompted

to select an object. Select the object; the Add Attribute dialog box will be displayed, as shown
in Figure 6-41. The options in this dialog box are discussed next.

Add Attribute @
Name |
Value
Height ~ 0.2000 [ invisible
Mote: an added attribute is for one block instance only.

[ ok ] [ Cacel | [ Hep |

Figure 6-41 The Add Attribute dialog box

The Name edit box is used for identifying an attribute tag. Specify the name of the attribute
in this edit box.
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Specify a value for the attribute text in the Value edit box. The specified value will be
displayed both in the drawing and reports.

Specify the height for the attribute value in the Height edit box. By default, 0.2000 is displayed in
the Height edit box.

Select the justification for the attribute value from the drop-down list adjacent to the Height
edit box. By default, Left is selected in the drop-down list.

Select the Invisible check box to make the attribute text invisible in the drawing. By default,
this check box is clear.

Specify the required options in the Add Attribute dialog box and choose the OK button in this
dialog box; you will be prompted to specify the location for attribute. By default, the first location
point is already selected by AutoCAD Electrical and it is 0, 0. Next, specify the second location
point and click on the screen; the attribute value will be inserted into the drawing.

Squeezing an Attribute/Text

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Squeeze Attribute/Text

Toolbar: ACE:Main Electrical > Modify Attributes drop-down> Squeeze Attribute/Text
or ACE:Edit Attributes > Squeeze Attribute/Text

Menu: Components > Attributes > Squeeze Attribute/Text

Command: AEATTSQUEEZE

" The Squeeze Attribute/Text tool is used to reduce the attribute or text size to make it
=#  suitable for tight places. After each click on the attribute or text, the width of the
attribute or text reduces by 5%. To squeeze the attribute or text size, choose the Squeeze
Attribute/Text tool from the Modify Attributes drop-down in the Edit Components panel of
the Schematic tab; you will be prompted to select the attribute or text to be squeezed. Select
the attribute or text; you will be prompted again to select the attribute or text. Continue the
selection till it is squeezed to a required size. Next, press ENTER to exit the command.

Stretching an Attribute/Text

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Stretch Attribute/Text

Toolbar: ACE:Main Electrical >Modify Attributes drop-down > Stretch Attribute/Text
or ACE:Edit Attributes > Stretch Attribute/Text

Menu: Components > Attributes > Stretch Attribute/Text

Command: AEATTSTRETCH

The Stretch Attribute/Text tool is used to expand the attribute or text size. After each
E click on the attribute or text, the width of the attribute or text increases by 5%. To stretch

an attribute, choose the Stretch Attribute/Text tool from the Modify Attributes
drop-down in the Edit Components panel of the Schematic tab; you will be prompted to select
the attribute or text. Select the attribute or text; the attribute or text will be stretched. The
command will continue till you press ENTER.
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Changing the Attribute Size

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Change Attribute Size

Toolbar: ACE:Main Electrical >Modify Attributes drop-down > Change Attribute Size
or ACE:Edit Attributes > Change Attribute Size

Menu: Components > Attributes > Change Attribute Size

Command: AEATTSIZE

L,_—> The Change Attribute Size tool is used to change the height and width of the attribute
ol text that has already been inserted into the drawing. To change the text size of the

attribute, choose the Change Attribute Size tool from the Modify Attributes drop-down
in the Edit Components panel of the Schematic tab; the Change Attribute Size dialog box will
be displayed, as shown in Figure 6-42. The options in this dialog box are discussed next.

Specify the size for the attribute in the Size edit box.
Specify the width for the attribute in the Width edit
box. Alternatively, choose the Pick >> button; you
will be prompted to select the attribute. Select the =

required attribute; the Change Attribute Size dialog Size ] Apply
box will be displayed again and the values of the Width  [10000 | ¥ Apply
selected attribute size and width will be displayed in

Change Attribute Size (==

the Size and Width edit boxes. By default, the Apply [ snge | [ ByName | [ Typet |
check boxes are selected. As a result, the new size and

width is applied to the attribute that you select. If you
clear the Apply check boxes in the Change Attribute
Size dialog box, the Single, By Name, and Type It
buttons will not be activated.

Figure 6-42 The Change Attribute
Size dialog box

The Single button is used to select one attribute at a time. The By Name button is used to
change the size and width of the same type of attributes. For example, if you select DESC2
attribute of a symbol, then the size and width of only DESC2 attribute of all the components
present in the drawing will get changed. Choose the By Name button; you will be prompted
to select the attribute/name. Select the attribute/name and press ENTER; the size and width of
the attributes of same type will be changed according to the specified size and width. You can
also select multiple attributes at a time. To do so, enter W at the Command prompt; you will
be prompted to specify the first corner. Specify the first corner; you will be prompted to specify
the opposite corner. Specify the opposite corner and then press ENTER; the size and width of
the selected attributes will get changed according to the specified size. Also, if you enter ALL at
the Command prompt, all attributes by the same name that are present in the drawing will be
selected and changed to the new attribute size. Press ESC to exit the command.

The Type It button is used to specify the name of the attribute to be matched to the selected
attributes. To do so, choose the Type It button; the Enter Attribute Name dialog box will be
displayed. Enter the attribute name in the edit box that you want to match to the attributes
that you will select. For example, DESC1 for description of the component, TAG1 for tag of the
component, and so on. Next, choose the OK button in the Enter Attribute Name dialog box;
you will be prompted to select blocks to process. Select the blocks and press ENTER; the size of
attributes will be changed accordingly. Alternatively, select multiple attributes by window selection.
Also, if you enter ALL at the Command prompt, all attributes present in the active drawing will
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be selected. Next, press ENTER to change the attributes to the new attribute size and width.
Note that you can also enter wildcards in the edit box and include a series of attribute names
to match by separating each attribute name using semi-colons.

If you do not enter any attribute name in the edit box of the Enter Attribute Name dialog box

and choose OK, then it will again return to the Change Attribute Size dialog box. Choose the
Cancel button to exit from this dialog box.

Rotating an Attribute

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Rotate Attribute

Toolbar: ACE:Main Electrical > Modify Attributes drop-down > Rotate Attribute
or ACE:Edit Attributes > Rotate Attribute

Menu: Components > Attributes > Rotate Attribute

Command: AEATTROTATE

¢, The Rotate Attribute tool is used to rotate the selected attribute text by 90 degrees. To
I‘EJ do so, choose the Rotate Attribute tool from the Modify Attributes drop-down in the
Edit Components panel of the Schematic tab; you will be prompted to select the
attribute text to rotate. Select the attribute text; the text will be rotated by 90 degrees in
counterclockwise direction. Press ENTER to exit the command. Now, if you want to move the
attribute text, enter ‘M’ at the Command prompt and press ENTER; you will be prompted to
specify the base point. Specify the base point and press ENTER; you will be prompted to
specify the destination point. Specify the destination point and press ENTER; the attribute text
will be moved to the specified location.

Changing the Justification of an Attribute

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Change Attribute Justification
Toolbar: ACE:Main Electrical > Modify Attributes drop-down>

Change Attribute Justification

or ACE:Edit Attributes > Change Attribute Justification
Menu: Components > Attributes >Change Attribute Justification
Command: AEATTJUSTIFY

'ff:> The Change.AttrlbulieJust}ﬁcatlon Fool 1sused to Change Attribute/Test Justfication =
change the justification of any attribute such as | ¢ -
K o elect Justification

wire number text, component description text, Left =
and so on. To change the justification of an attribute, | G
choose the Change Attribute Justification tool from the #“ﬂ;
Modify Attributes drop-down in the Edit Components | Top Center £
panel of the Schematic tab; the Change Attribute/Text | foyor
Justification dialog box will be displayed, as shown in hade &,Bgrgdef
Figure 6-43. The options in this dialog box are discussed | Bottom Lsf

Bottom Center %
next.
oK [ Cancel | [ Hep |

Select the required justification for the attribute text )
from the Select Justification area in this dialog box; the ~Figure 6-43 The Change Attribute/
Text Justification dialog box
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OK button will be activated. Choose OK; you will be prompted to select the text or attribute
to change the justification. Select the text or attribute; the justification of the attribute or text
will be changed.

Alternatively, choose the Pick Master button; you will be prompted to select the master attribute
or text that will be used for justification of other attributes or text. Next, select the attribute or
text; the Change Attribute/Text Justification dialog box will be displayed on the screen again.
Choose OK; you will be prompted to select the attribute or text for the change of justification.
Select attributes or text and press ENTER; the justification of attributes or text will be changed.
Alternatively, enter ‘W’ at the Command prompt to select the attributes or text by using a crossing
window. Press ENTER to exit the command.

Changing an Attribute Layer

Ribbon: Schematic > Edit Components > Modify Attributes drop-down >
Change Attribute Layer
Toolbar: ACE:Main Electrical > Modify Attributes drop-down >

Change Attribute Layer

or ACE:Edit Attributes > Change Attribute Layer
Menu: Components > Attributes > Change Attribute Layer
Command: AEATTLAYER

' The Change Attribute Layer tool is used to change the layer of the selected attribute.

£ Todo so, choose the Change Attribute Layer tool from the Modify Attributes drop-down

in the Edit Components panel of the Schematic tab; the Force Attribute/Text to a
Different Layer dialog box will be displayed, as shown in Figure 6-44.

Force Attribute/Text to a Different Layer @
Change to Layer: Force to layer used for
Wires wire number text
|| | that is placed on wires
Farce to layer used for
Teminals wire number text

that is placed on terminals
and Source/Destination signal amows

[ ok | [ Cancel | Help

Figure 6-44 The Force Attribute/Text to a Different Layer dialog box

Enter the name of the target layer in the Change to Layer edit box. Alternatively, choose the
List button; the Layers in Drawing dialog box will be displayed. Select the layer and choose
the OK button; the name of the target layer will be displayed in the Change to Layer edit box.

If you choose the Wires button, the WIRENO will be displayed in the Change to Layer edit
box. This button is used to change the layer of a selected attribute or text for the layer that has
been used for wire number text placed on wires.

If you choose the Terminals button, the WIREREF will be displayed in the Change to Layer
edit box. In this case, the layer of the attribute or text that you select will get changed to the
layer that is used for wire number text placed on terminals and source/destination signal arrow.
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, Note

@ The Wires button and the Terminals button in the Force Attributes/Text to a Different Layer
dialog box will be activated only if the WIRES layer and the TERMINALS layer, respectively,
are available in the active drawing.

After specifying the required options in the Force Attribute/Text to a Different Layer dialog
box, choose the OK button in this dialog box; you will be prompted to select the attribute or text
to move to layer. Select the attribute or text; the attribute or text layer will get changed to the
layer that you have entered in the Change to Layer edit box. Press ENTER to exit the command.

TUTORIALS
Tutorial 1

In this tutorial, you will insert a ladder and its components into a drawing. Next, you will use
the Copy Component, Scoot, Move Component, and Delete Component tools for copying,
scooting, moving, and deleting the inserted components. refer to Figure 6-45. Also, you will

hide the attributes of components. (Expected time: 30 min)
PB1B CRIA
14— o O CONTROL RELAY
®:
2 C‘R‘IIA % CONTROL RELAY
ht O
Bu
cR2 M a2 Ls3 -3 MOTOR CONTROL
3 ’_{l' ll‘ \J
L
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4 »—{'}—4
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CR2 M2 M1
o i} T vl LS8 MOTOR CONTROL
%
]
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Figure 6-45 Ladder diagram for Tutorial 1

The following steps are required to complete this tutorial:

Create a new drawing.

Insert ladder in the drawing.

Insert components and add descriptions.
Copy components.

Hide attributes.

Delete components.

Move components.

@me a0 TP



Schematic Editing 6-41

-

C
1.

2.

4.

Add wires.

Scoot components.
Trim wires.

Align components.
Save the drawing file.

reating a New Drawing

Activate the CADCIM project, if it is not already active.

Choose the New Drawing button from the Project Manager; the Create New Drawing
dialog box is displayed. Enter C06_tut01 in the Name edit box of the Drawing File area.
Select the template as ACAD_ELECTRICAL.dwt and enter Schematic Components in the
Description 1 edit box.

Choose the OK button; the C06_tut01.dwg drawing is created in the CADCIM project and
is displayed at the bottom of the drawing list in the CADCIM project.

Move the C06_tut01.dwg to the TUTORIALS subfolder of the CADCIM project.

Inserting Ladder into the Drawing

1.

Choose the Insert Ladder tool from Schematic > Insert Wires/Wire Numbers > H
Insert Ladder drop-down; the Insert Ladder dialog box is displayed. *

Set the following parameters in the Insert Ladder dialog box:

Width: 8.000 Spacing: 1.000
Ist Reference: 1 Rungs: 7
1 Phase: Select this radio button Yes: Select this radio button

After setting these parameters, click in the Length edit box; the length of the ladder is
automatically calculated and displayed in this edit box. Also, make sure that 0 is displayed
in the Skip edit box of the Draw Rungs area.

Choose the OK button; you are prompted to specify the start position of the first rung. Enter
11,18 at the Command prompt and press ENTER; the ladder is inserted into the drawing,

as shown in Figure 6-46.

Choose View > Zoom > In from the menu bar to zoom in the drawing.

Inserting Components and Adding Descriptions

1.

Choose the Icon Menu tool from Schematic > Insert Components > Icon Menu _(1;
drop-down; the Insert Component dialog box is displayed.

Select the Push Buttons icon from the NFPA: Schematic Symbols area of the Insert
Component dialog box; the NFPA: Schematic Symbols area is modified to the NFPA: Push
Buttons area.
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10.

11.

Figure 6-46 Ladder with 7 rungs

Select the Push Button NO icon from the NFPA: Push Buttons area; the cursor along with
the component is displayed and you are prompted to specify the insertion point for the
push button. Enter 11.5,18 at the Command prompt and press ENTER; the push button
is placed at rung 1 and the Insert / Edit Component dialog box is displayed.

By default, PB1B is displayed in the edit box of the Component Tag area.
Enter STOP in the Line 1 edit box in the Description area.

Choose the OK button from the Insert/ Edit Component dialog box; the PB1B component is
inserted into the drawing.

Repeat step 1. Select the Relays/Contacts icon displayed in the NFPA: Schematic Symbols
area of the Insert Component dialog box; the NFPA: Relays and Contacts area is displayed.

Select the Relay Coil icon in the NFPA: Relays and Contacts area of the Insert Component
dialog box; you are prompted to specify the insertion point. Enter 13,18 at the Command
prompt and press ENTER; the Insert/ Edit Component dialog box is displayed. By default,
CR1A is displayed in the edit box of the Component Tag area.

Enter CONTROL RELAY in the Line 1 edit box in the Description area.

Choose the OK button from the Insert/ Edit Component dialog box; the component CR1A
gets added to rung 1 of the ladder.

Repeat Step 1. Select the Relays/Contacts icon displayed on the right of the Insert
Component dialog box; the NFPA: Relays and Contacts area is displayed.

Select the Relay Coil icon in the NFPA: Relays and Contacts area of the Insert Component
dialog box; you are prompted to specify the insertion point. Enter 13.5,17 at the Command
prompt and press ENTER. By default, CR2 is displayed in the edit box of the Component
Tag area of the Insert / Edit Component dialog box.
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12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

Enter CONTROL RELAY in the Line 1 edit box in the Description area.

Choose the OK button from the Insert / Edit Component dialog box; the component CR2
gets added to rung 2 of the ladder.

Repeat Step 1. Select the Relays/Contacts icon and then select Relay NC Contact in the
NFPA: Relays and Contacts area of the Insert Component dialog box; you are prompted
to specify the insertion point. Enter 11.5,17 at the Command prompt and press ENTER;
the Insert / Edit Child Component dialog box is displayed.

Choose the Drawing button from the Component Tag area of the Insert / Edit Child
Component dialog box; the Active Drawing list for FAMILY = “CR” dialog box is displayed.
Select CR1A from this dialog box and choose the OK button; the information is displayed
in the Insert / Edit Child Component dialog box.

By default, CONTROL RELAY is displayed in the Line 1 edit box of the Description area.
Enter NORMALLY CLOSED in the Line 2 edit box of the Description area.

Choose the OK button in the Insert / Edit Child Component dialog box; the component
CRI1A is added to the ladder rung 2.

Repeat Step 1. Select the Relays/Contacts icon and then select Relay NO Contact in the
NFPA: Relays and Contacts area; you are prompted to specify the insertion point. Enter
11.5,16 at the Command prompt and press ENTER; the Insert / Edit Child Component
dialog box is displayed.

Choose the Drawing button from the Component Tag area of the Insert / Edit Child
Component dialog box; the Active Drawing list for FAMILY = “CR” dialog box is displayed.
Select CR2 from this dialog box and choose the OK button; the information is displayed in
the Insert / Edit Child Component dialog box.

Enter NORMALLY OPEN in the Line 2 edit box of the Description area in the Insert/ Edit
Child Component dialog box and then choose the OK button from this dialog box; the
CR2 control relay is inserted into the drawing in the rung 3.

Repeat step 1. Select the Motor Control icon from the NFPA: Schematic Symbols area in
the Insert Component dialog box. Next, select Motor Starter Coil from the NFPA: Motor
Control area; you are prompted to specify the insertion point for the component.

Enter 17.5,16 at the Command prompt and press ENTER; the Insert / Edit Component
dialog box is displayed. Enter M2 in the edit box of the Component Tag area. Also, enter
its description as MOTOR CONTROL in the Line 1 edit box of the Description area of
the Insert / Edit Component dialog box. Choose the OK button from this dialog box; the
Motor Starter Coil is inserted into rung 3 of the ladder.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

6-44 AutoCAD Electrical 2016 for Electrical Control Designers

23.

24.

25.

26.

27.

28.

29.

30.

31.

Note
You may need to move the attributes of the inserted components by using the Move/Show Attribute
tool.

Similarly, insert 2nd + Starter Contact NO in the rung 4. To do so, choose the Motor Control
icon from the Insert Component dialog box and then select 2nd +Starter Contact NO from
the NFPA: Motor Control area; you are prompted to specify the insertion point.

Enter 11.5,15 at the Command prompt and press ENTER; the Insert / Edit Child
Component dialog box is displayed. Choose the Drawing button from the Component Tag
area of the Insert/ Edit Child Component dialog box; the Active Drawing list for FAMILY
= “M?” dialog box is displayed. Select M2 from this dialog box and choose the OK button;
the information is displayed in the Insert / Edit Child Component dialog box.

Enter NORMALLY OPEN in the Line 2 edit box of the Description area in the Insert /
Edit Child Component dialog box and then choose the OK button from this dialog box;
the M2 starter contact is inserted into the drawing in the rung 4.

Repeat step 1. Select the Motor Control icon from the NFPA: Schematic Symbols area in
the Insert Component dialog box. Next, select Motor Starter Coil from the NFPA: Motor
Control area; you are prompted to specify the insertion point for the component.

Enter 18,13 at the Command prompt. Enter M1 in the edit box of the Component Tag area.
Also, enter its description as MOTOR CONTROL in the Line 1 edit box of the Description
area of the Insert / Edit Component dialog box. Choose the OK button from the Insert
/ Edit Component dialog box; the Motor Starter Coil (M1) is inserted into rung 6 of the
ladder.

Again, repeat step 1. Select the Motor Control icon and then select 2nd + Starter Contact NC
from the NFPA: Motor Control area of the Insert Component dialog box; you are prompted
to specify the insertion point for the component.

Enter 12.8,16 at the Command prompt and press ENTER; the Insert / Edit Child
Component dialog box is displayed. Choose the Drawing button from the Component Tag
area of the Insert/ Edit Child Component dialog box; the Active Drawing list for FAMILY
= “M” dialog box is displayed. Select M1 from this dialog box and choose the OK button;
the information is displayed in the Insert / Edit Child Component dialog box.

Enter NORMALLY CLOSED in the Line 2 edit box of the Description area in the Insert
/ Edit Child Component dialog box and then choose the OK button from this dialog box;
the Motor starter contact (M1) is inserted into the drawing in the rung 3.

Next, you need to insert Limit Switch, NC in the rung 3.
Choose the Limit Switches icon from the Insert Component dialog box; the NFPA: Limit

Switches area is displayed. Select Limit Switch, NC from this area; you are prompted to
specify the insertion point.
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32.

33.

34.

35.

36.

Enter 16,16 at the Command prompt and press ENTER; the Insert / Edit Component
dialog box is displayed. By default, LS3 is displayed in the Component Tag edit box of
the Insert / Edit Component dialog box. Also, enter LIMIT SWITCH and NORMALLY
CLOSED in the Line 1 and Line 2 edit boxes, respectively in the Description area of the
Insert / Edit Component dialog box. Choose the OK button; LS3 gets inserted into rung
3.

Similarly, insert Limit Switch, NO in the rung 1. To do so, choose the Limit Switch, NO
from the NFPA: Limit Switches icon of the Insert Component dialog box; you are prompted
to specify the insertion point.

Enter 18,18 at the Command prompt and press ENTER; the Insert/ Edit Component dialog
box is displayed. By default, LS1A is displayed in the edit box of the Component Tag area
in this dialog box. Next, choose the OK button; LSIA is inserted into rung 1 of drawing.
Figure 6-47 shows the ladder with components inserted in it.

Choose the Move/Show Attribute tool from Schematic > Edit Components > Modify
Attributes drop-down; you are prompted to select the object. Select the Motor Control
attribute of the Motor Starter Coil and press ENTER; you are prompted to specify the base
point.

Specify the base point at the left corner of the attribute and move the attribute, as shown
in Figure 6-47.
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Figure 6-47 Components inserted in the ladder

Copying Components

1.

Choose the Copy Component tool from the Edit Components panel of the — +Z¥
Schematic tab; you are prompted to select a component to copy. L
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10.

11.

12.

Select PB1B (push button) placed on rung 1; you are prompted to specify the insertion
point for the copied component. Enter 14,16 at the Command prompt and press ENTER;
the Insert / Edit Component dialog box is displayed.

By default, PB3 is displayed in the edit box of the Component Tag area. Enter DOWN in
the Line 1 edit box of the Description area of the Insert / Edit Component dialog box.

Choose the OK button from this dialog box; the component PB3 gets inserted into rung 3.

Similarly, right-click on CR2 placed on rung 3 and choose the Copy Component option
from the marking menu displayed; you are prompted to specify the insertion point. Enter
12,13 at the Command prompt and press ENTER; the Insert / Edit Child Component
dialog box is displayed.

Choose the Drawing button from the Component Tag area of the Insert / Edit Child
Component dialog box; the Active Drawing list for FAMILY = “CR” dialog box is displayed.
Select CR2 (third entry) from this dialog box and choose the OK button; the information
is displayed in the Insert / Edit Child Component dialog box.

By default, CONTROL RELAY is displayed in the Line 1 edit box of the Description area.
Enter NORMALLY OPEN in the Line 2 edit box of the Description area.

Choose the OK button in the Insert/ Edit Child Component dialog box; the component CR2
is inserted into rung 6 of the drawing.

Right-click on PB1B that you have placed on rung 1 and choose the Copy Component option
from the marking menu displayed; you are prompted to specify the insertion point. Enter
13,14 at the Command prompt and press ENTER; the Insert/ Edit Component dialog box
is displayed.

Remove the description from the Line 1 of the Description area in the Insert / Edit
Component dialog box. Also, enter PB5 in the edit box of the Component Tag area, if
it is not displayed. Next, choose the OK button in this dialog box; the PB5 is inserted on
rung 5. Again, copy the PB1B to rung 6. To do so, right-click on it and choose the Copy
Component option from the marking menu displayed; you are prompted to specify the
insertion point.

Enter 14,13 at the Command prompt and press ENTER; the Insert/ Edit Component dialog
box is displayed. In this dialog box, PB6 is displayed by default in the edit box of the
Component Tag area. Remove the description from the Line 1 edit box of the Description
area and choose the OK button; PB6 is inserted into rung 6 in the ladder.

Right-click on Motor control M2 that is on rung 4 and choose the Copy Component option
from the marking menu displayed; you are prompted to specify the insertion point. Enter
12,12 at the Command prompt and press ENTER; the Insert / Edit Child Component
dialog box is displayed.
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13.

14.

15.

16.

17.

Choose the Drawing button from the Component Tag area of the Insert / Edit Child
Component dialog box; the Active Drawing list for FAMILY = “M” dialog box is displayed.
Select M1 (first entry) from this dialog box and choose the OK button; the information is
displayed in the Insert / Edit Child Component dialog box.

Enter NORMALLY OPEN in the Line 2 edit box of the Description area in the Insert/ Edit
Child Component dialog box and then choose the OK button from this dialog box; the
Motor starter contact (M1) is inserted into the drawing in rung 7.

Similarly, select M1 from rung 3 and copy it to rung 6 at 15,13. Choose the Drawing button
from the Component Tag area of the Insert/ Edit Child Component dialog box; the Active
Drawing list for FAMILY = “M” dialog box is displayed. Select M2 (fourth entry) from
this dialog box and choose the OK button; the information is displayed in the Insert / Edit
Child Component dialog box.

Enter NORMALLY CLOSED in the Line 2 edit box of the Description area in the Insert
/ Edit Child Component dialog box and then choose the OK button from this dialog box;
the M2 starter contact is inserted into the drawing in rung 6.

Next, select limit switch LS3 from 3rd rung and copy it at 15,15. Again, select LS3 and copy
it at 16,13. You will notice that the limit switch is inserted in rung 4 and rung 6. Keep the
values in the Description area intact. Figure 6-48 shows the copied components.
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Figure 6-48 The copied components

Hldmg Attributes

Choose the Hide Attribute (Single Pick) tool from Schematic > Edit Components > Modify
Attributes drop-down; you are prompted to select the attributes to hide.

Select the DESC1 and DESC2 attributes of the following components:

CR1A placed on rung 2,

CR2, M1, PB3, and LS3 placed on rung 3,
M2 and LS4 placed on rung 4,

CR2, M2, and LS6 placed on rung 6, and
M1 placed on rung 7.
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On doing so, the description of the components is hidden.

3. Press ENTER to exit the command. Figure 6-49 shows the ladder and component with
hidden attributes.

Deleting Components
1. Choose the Delete Component tool from the Edit Components panel of the n ¥
. ) . H|
Schematic tab; you are prompted to select objects.

2. Select LS1A from rung 1 and LS4 from rung 4, and then press ENTER; the Search for / Surf
to Children? dialog box is displayed. Choose the No button from this dialog box; components
are deleted from the drawing, as shown in Figure 6-50.
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Figure 6-49 The ladder afier hiding attributes ~ Figure 6-50 The ladder after deleting components

Moving Components
1. Choose the Move Component tool from Schematic > Edit Components > Modify = <"+
Components drop-down; you are prompted to select the component to move. K

2. Select M2 from rung 6; you are prompted to specify the insertion point for the component.

3. Enter 13,13 at the Command prompt and press ENTER; M2 is moved to a new location in
rung 6, as shown in Figure 6-51.

Addmg Wires
Choose the Wire tool from Schematic > Insert Wires/Wire Numbers > Wire E
drop-down; you are prompted to specify the starting point of the wire at the *
Command prompt.

2. Enter 13.4,16 at the Command prompt and press ENTER; you are prompted to specify the
wire endpoint. Next, enter 13.4,15 and press ENTER; the wire is inserted between rung 3
and 4 on the left side of the PB3.

3. Enter 14.6,16 at the Command prompt and press ENTER; you are prompted to specify the
wire endpoint. Next, enter 14.6,15 and press ENTER; the wire is inserted between rung 3
and 4 on the right side of the PB3.
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Figure 6-51 M2 moved to a different location

Enter 13.4,15 at the Command prompt and press ENTER; you are prompted to specify the
wire endpoint. Next, enter 13.4,14 and press ENTER; the wire is inserted between rung 4
and 5.

Enter 14.6,15 at the Command prompt and press ENTER; you are prompted to specify the
wire endpoint. Next, enter 14.6,14 and press ENTER; the wire is inserted between rung 4
and 5.

Enter 13.4,13 at the Command prompt and press ENTER; you are prompted to specify the
wire endpoint. Next, enter 13.4,12 and press ENTER; the wire is inserted between rung 6
and 7 on the left side of the PB6.

Enter 14.6,13 at the Command prompt and press ENTER; you are prompted to specify the
wire endpoint. Next, enter 14.6,12 and press ENTER; the wire is inserted between rung 6
and 7 on the right side of the PB6.

Press ENTER to exit the command. Figure 6-52 shows the wires inserted in the drawing.

Scooting Components

1.

Choose the Scoot tool from Schematic > Edit Components > Modify Components e
drop-down; you are prompted to select the component. *

Select M2 from rung 4 and enter 14,15 at the Command prompt and then press ENTER;
M2 is moved to a new location.

Select PB5 from rung 5 and enter 14,14 at the Command prompt and then press ENTER;
PB5 is moved to a new location.

Select M1 from rung 7 and enter 14,12 at the Command prompt and then press ENTER;
M1 is moved to a new location.
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5. Press ENTER to exit the command. Figure 6-53 shows the schematic diagram after using
the Scoot tool.
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Figure 6-52 Wires inserted in the ladder Figure 6-53 The ladder after using the Scoot tool

1 ds

Trimming Wires
1. Choose the Trim Wire tool from the Edit Wires/Wire Numbers panel of the ﬁ
Schematic tab; you are prompted to select the wire to trim.

2. Select the following wires to trim: right and left portions of rung 4, rung 5, and rung 7.

3. Press ENTER to exit the command.

Aligning Components

1. Choose the Align tool from Schematic > Edit Components > Modify Components 5
drop-down; you are prompted to select the component to align horizontally or E=
vertically.

2. Select PB1B on rung 1; an imaginary line passing through the center of PB1 is displayed
and you are prompted to select objects.

3. Select CR1A placed on rung 2, CR2 placed on rung 3, and CR2 placed on rung 6 from the
left of the ladder.

4. Press ENTER; the components are aligned toward the left.

5. Repeat stepl. Select M1 from rung 3; an imaginary line passing through the center of M1
is displayed and you are prompted to select objects. Next, select M2 placed on rung 6 and
press ENTER; M1 placed on rung 3 and M2 placed on rung 6 are aligned.

6. Repeat step 1 and then select M1 placed on the right side of rung 6. Next, select M2 placed
on rung 3, CR2 placed on rung 2, and CRIA placed on rung 1 and press ENTER; the
selected components are aligned.

7. Repeat step 1 and then select PB3 from rung 3; you are prompted to select objects. Next,
select M2 placed on rung 4, PB5, PB6, and M1 placed on rung 7 from the drawing and
then press ENTER; the selected components are aligned. Figure 6-54 shows the aligned
components.
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Figure 6-54 The trimmed wires and the aligned components

Saving the Drawing File
1. Choose Save from the Application Menu to save the drawing file C06_tut01.dwg.

Tutorial 2

In this tutorial, you will correct errors in C06_tut01.dwg drawing file of the CADCIM project
by using the Electrical Audit and Drawing Audit tools. Also, you will add catalog data to the
components. (Expected time: 20 min)

The following steps are required to complete this tutorial:

Open the drawing.

Audit the drawing using the DWG Audit tool.
Audit the drawing using the Electrical Audit tool.
Save the drawing file.

S

Opening the Drawing

1. Right-click on C06_tut01.dwg drawing file of the CADCIM project in the Projects rollout
of the Project Manager; a shortcut menu is displayed. Choose the Open option from the
shortcut menu; the drawing is opened.

Auditing the Drawing using the DWG Audit Tool
1. Choose the DWG Audit tool from the Schematic panel of the Reports tab from the |_3|
menu bar; the Drawing Audit dialog box is displayed. W
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2. Select the Active drawing radio button, if it is not selected by default.
3. Choose the OK button; the modified Drawing Audit dialog box is displayed.

4. Choose the OK button from the modified Drawing Audit dialog box; the Drawing Audit
message box is displayed.

5. Choose the OK button in the Drawing Audit message box; the Report: Audit for this
drawing dialog box is displayed.

6. Choose the Close button from the Report: Audit for this drawing dialog box.

The visual wire indicators in the diagram are shown in red color, refer to Figure 6-55.
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Figure 6-55 Visual wire indicators indicating wires in the drawing

7. Choose View > Redraw from the menu bar to eliminate the wire indicators.

Audltmg the Drawing Using the Electrical Audit Tool
Choose the Electrical Audit tool from the Schematic panel of the Reports tab: the |r| |
Electrical Audit dialog box is displayed.

2. Select the Active Drawing radio button from the Electrical Audit dialog box; the errors
in the C06_tut01.dwg drawing file are displayed in the edit box located on the right of the
Active Drawing radio button.

3. Choose the Details button from the Electrical Audit dialog box to expand it.

4. Choose the Component - No Catalog Number tab from the Electrical Audit dialog box.
Next, select the PB1B push button from the Tag Name column of this tab.
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5.

Choose the Go To button; PB1B push button is zoomed.

Note
After choosing the Go To button, if the QSAVE message box is displayed, choose the OK button in
this message box to save the changes.

Right-click on the PB1B component; a marking menu is displayed. Choose the Edit
Component option from the marking menu; the Insert / Edit Component dialog box is
displayed.

Choose the Project button from the Catalog Data area of the Insert/ Edit Component dialog
box; the Find: Catalog Assignments dialog box is displayed. Select the Active Project radio
button, if it is not selected.

Choose the OK button from the Find: Catalog Assignments dialog box; the HPB11/VPB11
catalog values(this project) dialog box is displayed.

Note
@ If the QSAVE message box is displayed, choose the OK button in it to save the changes.

10.

11.

12.

13.

14.

Select the 800T-A2A catalog number from the Catalog Number column and choose the
OK button from the HPB11 / VPB11 catalog values dialog box; AB is displayed in the
Manufacturer edit box and 800T-A2A is displayed in the Catalog edit box of the Insert/ Edit
Component dialog box.

Next, choose the OK button from the Insert/ Edit Component dialog box to save the changes
and exit this dialog box. Now, you can notice ‘x’ on the left of the PB1B in the Electrical

Audit dialog box.

Choose the Close button from the Electrical Audit dialog box. In this manner, you can
rectify the missing catalog number error from the drawing.

Now, you need to check whether an error is rectified or not.
Choose the Electrical Audit tool from the Schematic panel of the Reports tab; the Electrical
Audit dialog box is displayed. Choose the Active Drawing button to display the errors in

the active drawing.

Choose the Details button to expand this dialog box. Next, choose the Component - No
Catalog Number tab from the Electrical Audit dialog box.

You will notice that the selected error is corrected and is not displayed in the Electrical
Audit dialog box. In other words, PB1B is not displayed in the list.

Choose the Close button to exit the Electrical Audit dialog box.

Saving the Drawing File

1.

Choose Save from the Application Menu to save the drawing file.
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Tutorial 3

In this tutorial, you will create a schematic drawing. Next, you will add catalog data to one of
the components and then copy it to other components. Also, you will add location data to one
of the control relay and copy it to the rest of the control relays. (Expected time: 40 min)

o AN o

C
1.

The following steps are required to complete this tutorial:

Create a new drawing.

Insert the ladder.

Insert components in the ladder.
Copy the catalog data.

Enter the location data.

Save the drawing file.

reating a New Drawing

Choose the New Drawing button in the Project Manager; the Create New
Drawing dialog box is displayed. Enter C06_tut03 in the Name edit box of the [
Drawing File area.

Choose the Browse button located on the right of the Template edit box; the Select template
dialog box is displayed. Select the ACAD_ELECTRICAL template and choose the Open
button; the location and path of the template file is displayed in the Template edit box.

Enter Schematic Components in the Description 1 edit box.

Choose the OK button in the Create New Drawing dialog box; the C06_tut03.dwg drawing is
created and displayed at the bottom of the drawing list in the CADCIM project.

Move C06_tut03.dwg to the TUTORIALS subfolder of the CADCIM project.

Inserting the Ladder

1.

2.

4.

Choose the Insert Ladder tool from Schematic > Insert Wires/Wire Numbers > E
Insert Ladder drop-down; the Insert Ladder dialog box is displayed. +

Set the following parameters in the Insert Ladder dialog box:

Width: 6.000 Spacing: 1.000
Ist Reference: 101 Rungs: 7

Make sure that the 1Phase radio button in the Phase area and the Yes radio button in the
Draw Rungs area are selected. Do not change values in the rest of the edit boxes.

Click in the Length edit box; the length of the ladder is automatically calculated and
displayed in the edit box.

Choose the OK button; you are prompted to specify the start position of the first rung.
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5. Enter 8,13 at the Command prompt and press ENTER; the ladder is inserted into the

drawing.

6. Choose View > Zoom > Extents from the menu bar; the drawing gets zoomed.

Inserting Components in the Ladder

1.

Choose the Icon Menu tool from Schematic > Insert Components > Icon Menu
drop-down; the Insert Component dialog box is displayed.

&

2. Select the Push Buttons icon from the NFPA: Schematic Symbols area of the Insert
Component dialog box. Next, select the Push Button NO icon in the NFPA: Push Buttons
area; the cursor along with the component is displayed on the screen and you are prompted
to specify the insertion point for the push button.

3. Enter 8.5,13 at the Command prompt and press ENTER; the push button is placed at

rung 1 and the Insert / Edit Component dialog box is displayed. Next, make sure PB101
is displayed in the Component Tag edit box and START in the Linel of the Description
area. Next, choose the OK button in the Insert / Edit Component dialog box. Similarly,

insert other components as mentioned in Table 1.

Table 1 Components to be inserted in the ladder

Rung Component to be | Insertion point | Component tag | Descriptions to be
Number [ selected from the | tobe specified at | values tobe specified | specified in the
Insert Component | the Command | in the Component | Description area
dialog box prompt Tag edit box of|of the Insert /
the Insert / Edit [ Edit Component
Component dialog [or Insert / Edit
box, if it is not|child Component
already displayed | dialog box
101 Limit Switch, NC |[9.5,13 L5101 UPp
101 Relay Coil 11.5,13 CR101 CONTROL RELAY
102 Relay NO Contact | 9,12 CR101 CONTROL RELAY
103 Relay NO Contact | 9,11 CR101 CONTROL RELAY
103 Relay NC Contact | 10.5,11 CR 101 CONTROL RELAY
103 1 Phase Motor 12.5,11 MOT103 DOWN MOTOR
104 Relay NO Contact | 9,10 CR101 CONTROL RELAY
105 Relay Coil 11.5,9 CR105 CONTROL RELAY
106 Relay Coil 11.5,8 CR106 CONTROL RELAY
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106

Relay NC Contact

10.5,8

CR105

CONTROL RELAY

107

Relay NO Contact

9,7

CR106

CONTROL RELAY

4. After entering description and other information in the Insert / Edit Component or
Insert / Edit Child Component dialog box, choose the OK button; the components are
inserted in the drawing, as shown in Figure 6-56.

Copying the Catalog Data
1. Choose the Copy Catalog Assignment tool from Schematic > Edit Components >
Edit Components drop-down; you are prompted to select the master component.

@

2. Select CR101 placed on rung 101 as the master component; the Copy Catalog
Assignment dialog box is displayed.
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[ ]
o1 PBIOT 5109 ol CONTROL RELAY
—° o \
B~
CR101
102 ] L
"}
MOT103
103 oo e /)
CR101
104 | E
CR105
108 — CONTROL RELAY
\
10
CR106
108 CR105 ~ CONTROL RELAY
-lu
mm
CR106
107 i
[ "]

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

3. Choose the Catalog Lookup button; the Catalog Browser dialog box is displayed, as shown

Figure 6-56 Components inserted in the drawing

in Figure 6-57.

4. Select the row which contains 700-P200A1 in its Catalog column and then choose the OK
button; the Copy Catalog Assignment dialog box is displayed again. In this dialog box,
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AB is displayed in the Manufacturer edit box and 700-P200A1 is displayed in the Catalog
edit box.

A Catalog Browser ==
Category: | CR (Control relays) ~ @)
Search: [AB "TYPE p" 120VAC ~[a]
Results 2
CATALOG MANUFACTURER | DESCRIPTION TYPE  COIL  CONTACTS MISCELLANEQUS2
700-P200AL |aE P TYPE ELECTRICALLY HELD RELAY, 4 POLE, AC CC|TvPE P |120vAC|2NO 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 10A OPEN TYPE RELAY RAILMOL *
700-PA0AL_|AE P TYPE ELECTRICALLY HELD RELAY, 4 POLE, AC CC|TVPEP_|120vAC|4 NO 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 10A, OPEN TYPE RELAY RAIL MOV|
700-PE00AL | AB P TYPE ELECTRICALLY HELD RELAY, 6 POLE, AC CC|TVPEP_|120vAC|6 NO 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 10A OPEN TYPE RELAY RAILMOU =
700-PKE00AL | AB PXTYPE ELECTRICALLY HELD RELAY, 6 POLE, AC C|TVPE PK | 120vAC|6 NO 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 20A CONVERTIBLE CONTACT
700-PK1000A1 |AE PKTYPE ELECTRICALLY HELD RELAY, 12 POLE, AC | TVPE PK | 120VAC|10NO | 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 20A, CONVERTIBLE CONTACT |
700-PK1200A1 |AE PK TYPE ELECTRICALLY HELD RELAY, 12 POLE, AC | TVPE PK |120VAC|12NO | 115-120VAC 60Kz / 110VAC 50Hz COIL, RATING: 204, CONVERTIBLE CONTACT
700-PK201AL | A8 PK TYPE ELECTRICALLY HELD RELAY, 4 POLE, AC C|TVPE PK | 120¥AC|2 NO 115-120VAC 60Hz / 110VAC 50Hz COIL, RATING: 20A CONTACT w/ ENCLOSURE, C
700-PKAOIAL | AB PK TYPE ELECTRICALLY HELD RELAY, 4 POLE, AC C| TVPE PK | 120¥AC|4 NO 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 20A, CONTACT w/ ENCLOSURE, C
700-PKEOIAL | A8 PK TYPE ELECTRICALLY HELD RELAY, & POLE, AC C| TVPE PK | 120¥AC|6 NO 115-120VAC 60Hz / 110VAC 50Hz COIL, RATING: 20A CONTACT w/ ENCLOSURE, C
700-PKEOIAL | A8 PK TYPE ELECTRICALLY HELD RELAY, & POLE, AC C| TVPE PK | 120¥AC|8 NO 115-120VAC 60Hz / 110VAC 50Rz COLL, RATING: 20A CONTACT w/ ENCLOSURE, C.
700-PK1001AL | A8 PK TYPE ELECTRICALLY HELD RELAY, 12 POLE, AC | TVPE PK | 120vAC| 10NO___|115-120VAC 60Hz / 110VAC 50Hz COIL, RATING: 20A CONTACT w/ ENCLOSURE, C
700-PK1201A1 |AB PXTYPE ELECTRICALLY HELD RELAY, 12 POLE, AC | TVPE PK | 120VAC|12NO | 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 20A, CONTACT w/ ENCLOSURE, C
700-PHI00AL|AE PH TVPE ELECTRICALLY HELD RELAY, 2 POLE, AC | TVPE PH | 120vAC|1 NO 115-120VAC 60Hz / 110VAC 50Hz COLL, RATING: 35A, OPEN TVPE RELAY RAIL MOL
700-PH200AT | A8 PH TVPE ELECTRICALLY HELD RELAY, 2 POLE AC (| TVPE PH | 120vAC|2 NO 115-120VAC 60Hz / 110VAC 50Hz COIL, RATING: 35A OPEN TVPE RELAY RAIL MOU
700-PH300AL | A8 PH TVPE ELECTRICALLY HELD RELAY, 4 POLE, AC (| TVPE PH | 120vAC|3 NO 115-120VAC 60Hz / 110VAC 50Hz COIL, RATING: 35A, OPEN TVPE RELAY RAIL MOU
700-P800B1T__|AB P TYPE ELECTRICALLY HELD RELAY, 8 POLE, AC CC|TVPEP_|120¥AC|8 NO 120VAC 60Hz / 110-115VAC 50Hz COIL, RATING: 10A OPEN TVPE RELAY RAIL MOU
700-P1000BIL_| A8 P TYPE ELECTRICALLY HELD RELAY, 12 POLE, AC C|TVPEP_|120vAC|10NO___|120VAC 60z / 110-115VAC 50Hz COIL, RATING: 104 OPEN TVPE RELAY RAIL MOU
700-PL200BIL | A8 P TYPE ELECTRICALLY HELD RELAY, 12 POLE, AC C|TVPEP_|120vAC|12NO___|120VAC 60Hz/ 110-115VAC 50Hz COIL, RATING: 10A, OPEN TVPE RELAY RAIL MOU
700-P201811__|AB P TYPE ELECTRICALLY HELD RELAY, 4 POLE, AC CC|TVPEP_|120VAC|2 NO 120VAC 60Hz / 110-115VAC 50Kz COIL, RATING: 10A CONTACT w/ ENCLOSURE C
< T ] »
Record Count: 88 [T Filter by WDBLKNAM value: CR1 Search Database:

Figure 6-57 The Catalog Browser dialog box

Choose the OK button from the Copy Catalog Assignment dialog box; you are prompted
to select the target components.

Select CR105 and CR106 placed on rung 105 and rung 106, respectively and press ENTER;
the Update Related Components? message box is displayed. Choose the Skip button; the
catalog data is copied to the selected components.

Note
Choose the OK button from the QSAVE message box, if it is displayed.

To check the catalog data of CR105 and CR106, right-click on these components one by one;
a shortcut menu is displayed. Next, choose the Edit Component option; the Insert / Edit
Component dialog box is displayed. You will notice that the catalog data information is
displayed in the Catalog Data area of the Insert / Edit Component dialog box. Choose the
OK button in this dialog box to close it.

Entering the Location Data

1.

Click on the down arrow given on the right of the Edit Components panel of the =44
Schematic tab; a flyout will be displayed. Choose the Copy Installation/Location Code
Values button from the flyout; the Copy Installation/Location to Components
dialog box is displayed.

Make sure the Location check box is selected and then enter MCAB5 in the Location edit
box.

Choose the OK button; you are prompted to select objects. Next, select CR105 and CR106
placed on rung 105 and rung 106, respectively, and then press ENTER; the Update
Related Components? message box is displayed.
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4. Choose the Skip button from the Update Related Components? message box; the
location codes are assigned to the selected components. If the QSAVE message box
is displayed, choose the OK button from it; the drawings get updated and MCAB) is

displayed on the CR105 and CR106, as shown in Figure 6-58.
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Figure 6-58 The updated drawing

Saving the Drawing File

1. Choose Save from the Application Menu to save the drawing file.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this

chapter:

1. Which of the following commands is used to copy components?

(a) AECOMPONENT

(c) AEWIRE

(b) AECOPYCOMP
(d) AEAUDIT
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2.

3.

4

8.

9.

The default format for component tagging is

The tool is used to change the text size and width of attributes.

The tool is used to update or retag components.

The tool is used to copy the selected components.

The button of the Electrical Auditing dialog box is used to display the

detailed information of the errors found in a project.
You can scoot a component in any direction. (1/F)
You can align components only vertically. (T/F)

The Electrical Audit tool is used to correct potential errors in a project. (1/F)

10. You cannot print an auditing report. (1/F)

Review Questions

Answer the following questions:

1.

Which of the following tabs of the Electrical Audit dialog box displays the missing or
duplicated wire numbers in a project?

(a) Cable Exception (b) Component - No Connection
(c) Wire Exception (d) Wire - No Connection

Which of the following buttons is used to align components vertically or horizontally?

(a) Move (b) Pick Master
(c) Scoot (d) Align

Which of the following buttons is used to change the state of a normally open (NO)
component to a normally closed (NC) and vice-versa?

(a) Toggle NO/NC (b) Project-Wide Update/Retag
(c) Setup (d) Copy Component

Which of the following check boxes should be selected to retag all non-fixed components
of the drawing(s)?

(a) Component Cross-Reference Update (b) Wire gap pointers
(c) Wire Number and Signal Tag/Retag (d) Component Retag
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5. When you choose the Go To button in the Electrical Audit dialog box, AutoCAD Electrical
takes you to the error location in the project and rectify the error. (1/F)

6. Ifyou select the Title Block Update check box, the title block information of only the active
drawing will be updated. (1/F)

7. By choosing the Move Component button, you can reposition a selected component from
its current location or wire location and insert it at a new location. ('1/F)

8. The auditing tools find out errors in project drawings. (T/F)

9. The Move/Show Attribute tool is used to move attributes. ('1/F)

EXERCISES
Exercise 1

In this exercise, you will create a new drawing named C06_exer01.dwg and insert a ladder with
Width = 5, Spacing= 1, Rungs = 6, and 1st reference = 500. Also, you will insert components
in the ladder, as shown in Figure 6-59. In addition, you will use the basic editing tools such as
Copy Component and Align Component to copy and align the components, respectively. You
will use the Wire tool to insert wire between rung 500 and rung 501 and the Trim Wire tool
to trim the wire. (Expected time: 25 min)

Exercise 2

In this exercise, you will audit the NEW_PROJECT project using the DWG Audit and
Electrical Audit tools. Also, you will save the report on the desktop as drawing_audit.txt and
electrical_audit.ixt. (Expected time: 15 min)

Exercise 3

In this exercise, you will open the C06_exer01.dwg drawing file and save it as C06_exer03.dwg in
the NEW_PROJECT project. Next, you will change ladder references, component tags, and
cross-references from reference-based to sequential using the Update/Retag tool, refer to Figure
6-60. (Expected time: 20 min)

Hint: Enter 1 in the edit box on the right of the Sequential radio button in the Change Each
Drawing’s Settings - Project-wide dialog box.
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Figure 6-59 Components inserted in the ladder
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Figure 6-60 References changed using the Update/Retag tool

Answers to Self-Evaluation Test
1. b, 2. %F%N, 3. Change Attribute Size, 4. Update/Retag, 5. Copy Component, 6. Details, 7.
F,8.F9.F10. T



